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Tietoja oppaasta 

  

 

Tervetuloa kurssille! 

Materiaali on tarkoitettu 2-päiväisen Power BI perusteet -kurssin 

tukimateriaaliksi, aiheiden kertaamiseen ja yksityiskohtien syventämiseen 

kurssin jälkeen sekä ennakkomateriaaliksi muille Corellian kursseille. 

Aineisto on suunniteltu henkilöille, jotka toteuttavat liiketoiminnan 

raportointia.  

Oppaan lisäksi kurssimateriaaliin sisältyy 

• kalvosarja 

• harjoituskokonaisuus 

• esimerkkitiedostoja 

• kurssin jälkeisiä lisäharjoituksia 

Opas on sisällöllisesti laajempi kuin Power BI peruskurssi, sillä Power BI -

kursseille osallistuu hyvin erilaisia käyttäjiä aina sovelluskehittäjistä ja BI-

asiantuntijoista ns. tavallisiin ohjelmistojen peruskäyttäjiin. Aineisto ja 

aineistossa olevat linkit tarjoavat taustoiltaan erilaisille osallistujille 

lisätietoja ja mahdollisuuden syventää osaamistaan koulutuksen jälkeen. 

Power BI -tuote päivittyy säännöllisesti ja uusia ominaisuuksia julkistetaan 

tiiviiseen tahtiin kuukausittain. Materiaali on päivitetty 02/2022 ja perustuu 

uuteen 2022/02 julkaistuun muotoilukäyttöliittymään.  

Corellian kurssivalikoima 

 

Lisätietoja: Power BI - Corellia Helsinki Oy  

https://corellia.fi/kurssit/power-bi/
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Merkintätavat 

Englanninkielinen komento tai termi on lihavoituna ja suomenkielinen on 

sulkeissa. Kuten Home > Get Data > Web (Aloitus > Nouda tiedot > 

Verkko). 

Power BI:stä on olemassa sekä pilviversio (Power BI Service) että omaan 

konesaliin asennettava raportointipalvelin (Power BI Report Server). 

Pilviversio on huomattavasti raportointipalvelinta yleisempi, joten 

pilviversion ominaisuudet korostuvat materiaalissa.  

Materiaalissa on käytetty symboleita kuvaamaan eri versioihin liittyviä 

ominaisuuksia ja toimintoja: 

 
Pilvi 

 
Oma konesali 
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1 Johdanto Power BI:hin 

Power BI:n avulla dataa on helppo yhdistellä yritysten omista 

järjestelmistä, tiedostoista, intrasta, pilvipalveluista sekä netistä.  

Power BI:ssä on valmiita tietolähdekonnektoreita lähes 200 kappaletta ja 

niitä julkistetaan säännöllisesti lisää. Dataa voi ladata Power BI:hin myös 

erilaisten ajureiden avulla (ODBC, OLE DB) sekä erilaisista rajapinnoista. 

Lisäksi konnektoreita voi koodata itse. 

Power BI:n avulla dataa voi esittää erilaisina KPI-mittareina sekä 

vuorovaikutteisina visualisointeina ja se soveltuu loistavasti sekä 

itsepalvelu-raportointiin (self-service) että organisaatiotason 

keskitetympään ja laajempaan raportointiin. 
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1.1 Ohjeita 

Power BI -ohjeet ovat laadukkaita ja 

ne ovat saatavilla helposti suoraan 

työvälineistä, kuten Power BI 

Desktopissa Help (Ohje) -

välilehdeltä. 

 

© Help > Guided learning -osiosta löytyy erilaisia oppimispolkuja. 

© Help > Training videos vie YouTube-kanavalle, jossa on runsaasti 

laadukasta hyvää videosisältöä. 

© Help > Documentation (Ohje > Ohjeet) sivuilla ohjeet on jaettu eri 

aihepiireihin. 

© Help > Support (Ohje > Tuki) ilmainen tukipalvelu maksullisen Pro-

lisenssin haltijoille. 

© Help > Power BI blog (Ohje > Power BI -blogi) on Power BI –tiimin 

blogi, jossa Power BI -tiimi kertoo uudistuksista ja jakaa muuta 

hyödyllistä sisältöä. 

© Help > Community (Ohje > Yhteisö) sisältää keskusteluita ja 

kysymyksiin saa usein nopeita vastauksia. 

© Help > Submit an idea (Ohje > Lähetä idea) on Power BI –

kehitysideoiden esittämiseen ja niiden äänestämiseen sekä 

kehitysprosessin seuraamiseen tarkoitettu sivusto. 

© Help > External Tools (Ohje > Ulkoiset työkalut) -sivuilta löytyy 

tietoa Power BI -tuotteeseen läheisesti liittyvistä hyödyllisistä muista 

välineistä, kuten DAX Studiosta.  

© Help > Examples > Sample dataset (Ohje > Esimerkkejä > 

Mallitietojoukko) ja Sample reports (Näyteraportit) -valinnoilla saat 

ladattua erilaisia esimerkkitiedostoja. 

© Help > Examples > Community Galleries (Ohje > Esimerkkejä > 

Yhteisön valikoimat) sisältää erilaisia gallerioita, kuten 

esimerkkivisualisointeja, joista voi saada hyviä toteutusideoita omiin 

raportteihin.  

Suomeen on myös perustettu Power BI -käyttäjäyhteisö, johon voi liittyä 

meetupissa: https://www.meetup.com/Microsoft-BI-Power-BI-User-Group-

Finland/  jonka yksi perustajajäsen Corellian Power BI -kouluttaja Heidi 

Enho on. 

https://www.meetup.com/Microsoft-BI-Power-BI-User-Group-Finland/
https://www.meetup.com/Microsoft-BI-Power-BI-User-Group-Finland/
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1.2 Työvälineet ja työvaiheet 

Power BI:stä on olemassa kaksi eri versiota 

1) Power BI pilvessä ja 

2) Power BI omassa konesalissa 

Jos raportteja jaetaan omassa konesalissa olevan raportointipalvelimen 

kautta, Power BI -ominaisuudet ovat huomattavasti vähäisempiä kuin 

pilvipalvelussa. 

 
 

Raporttitiedostot toteutetaan ilmaisella Power BI Desktop ohjelmalla. 

Desktopista on kaksi eri versiota, joista toinen on pilviyhteensopiva ja 

toinen on tarkoitettu raportointipalvelimen kanssa käytettäväksi (Power BI 

Desktop optimized for Report Server). 

Lopputulos julkaistaan sekä jaetaan muille joko Power BI Service -

pilvipalvelun tai omaan konesaliin asennetun Power BI Report Serverin 

avulla.  

Loppukäyttäjät voivat hyödyntää sisältöä joko selaimella, mobiilisti, 

upotettuina esimerkiksi M365 -sovelluksissa, erilaisissa verkkosivustoissa 

tai sovelluskehittäjien koodaamissa sovelluksissa.  
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(*) Premium-lisenssit sisältävät myös mahdollisuuden julkaista Power BI 

Report Builder -nimisellä työkalulla toteutettuja pikselintarkkoja 

monisivuisia perinteisempiä raportteja. Esimerkiksi tuloslaskelma tai tase 

ovat hyviä esimerkkejä monisivuisista Power BI Report Builder -

raporteista. Power BI Report Builder on käytännössä sama työkalu, jolla on 

tehty perinteisiä SQL Server Reporting Services -raportteja (SSRS). 

Alla on kuvattu Power BI -raporttien laatimisen työvaiheet. 

 

 

Visualisointeja ja raporttisivuja voi luoda ja muokata myös selaimella 

pilvipalvelussa. Tiedon mallinnus ja laskentalogiikan toteutus edellyttävät 

PBI Desktopin, joten usein kaikki 4 ensimmäistä työvaihetta tehdään 

Desktopissa. 

Seuraavalla sivulla kuvataan muutamia erilaisia Power BI -

käyttöskenaarioita, sillä Power BI -raportointi ei välttämättä tarkoita 

kaikille käyttäjille samaa asiaa. Tällä kurssilla keskitytään Vaihtoehto 1 -

tyyppiseen raportointiin eli oletetaan, että kurssilaiset toteuttavat kaiken 

alusta lähtien itse Power BI Desktopissa. 
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1.3 Käyttötavat vaihtelevat eri tilanteissa ja eri organisaatioissa 

Kun puhutaan Power BI -raporttien laatimisesta, se voi tarkoittaa hyvin eri 

tyyppistä raportointitilannetta organisaatiosta ja käyttötapauksesta 

riippuen.  

Vaihtoehto 1 

Raporttien laatija voi toteuttaa raportointia suoraan erilaisista 

tietolähteistä, jolloin hänen pitää tuntea hyvin sekä Power BI -väline, data 

sekä tiedon mallintamiseen liittyviä lainalaisuuksia. 

Vaihtoehto 2 

Mikäli raportointi perustuu tietovarastossa olevaan jo osin valmiiksi 

mallinnettuun ja siivottuun dataan, raportointi on yleensä selvästi 

helpompaa ja suoraviivaisempaa. 

Vaihtoehto 3 

Kaikkien suppeimmin Power BI Desktopin -ominaisuuksia käyttää sellainen 

käyttäjä, joka toteuttaa raportteja valmiista muiden kehittäjien 

toteuttamista malleista, kuten AS (Azure Analysis Services tai SQL Server 

Analysis Services) tai Power BI Datasets -malleista. Tällöin PBI Desktopissa 

laaditaan vain raportteja sekä mahdollisesti raporttikohtaisia laskennallisia 

mittareita. 
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1.4 Lisenssit 

 

 

Pienet ja keskisuuret organisaatiot 

 

Power BI Desktop on kaikille ilmainen, mutta pilveen 

julkaistujen raporttien jakaminen muille organisaation 

käyttäjille edellyttää maksullisen Power BI Pro tai Power BI 

Premium per User -pilvipalvelulisenssin sekä raporttien 

kehittäjiltä että niiden katsojilta. Pro lisenssin listahinta 

yrityksille on hieman yli 8 € per käyttäjä per kuukausi ja 

Premium Per User -lisenssin hinta on noin 17 € per käyttäjä 

per kuukausi. Premium Per User on teknisiltä 

ominaisuuksiltaan monipuolisempi kuin Pro. 

 

Isot organisaatiot 

Isommille organisaatioille tarkoitetussa 

kapasiteettiperusteisessa Power BI Premium -

lisenssimallissa vain raporttien kehittäjät tarvitsevat Pro-

lisenssin. Pro-lisenssi tarvitaan, jotta voi tuottaa sisältöä 

raportointityötiloihin ja jakaa ratkaisuita muille käyttäjille. 
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Raporttien käyttäjät eivät tarvitse erillisiä lisenssejä. 

Premium-lisenssillä hankintaan kapasiteettia, joka maksaa 

hieman yli 4 200 € per kuukausi per kapasiteettiyksikkö 

(node). 

Ilmaislisenssillä Power BI:tä voi käyttää lähinnä omaan 

henkilökohtaiseen käyttöön tai jakaa sisältöä täysin julkisesti 

pilvipalvelusta löytyvällä Publish to web (Julkaise verkkoon) 

-komennolla, mikäli ominaisuuden käyttö on sallittu 

organisaation Power BI -hallintaportaalissa. 

Power BI:stä on saatavilla myös muutamia erilaisia ns. 

embedded-lisenssejä, joiden ominaisuudet ovat rajalliset ja 

joita käyttämällä sisältöä voi jakaa vain sovelluksiin 

upottamalla. Kuukausihinta alkaa noin 600 eurosta. 

 

Raportteja voi jakaa myös omaan konesaliin asennetun 

Power BI Report Serverin avulla. Power BI Report Server 

tulee sekä Premium-lisenssin mukana että sisältyy ilman 

erillistä lisäkustannusta SQL Server Enterprise Edition 

lisenssiin, jos organisaatiolla on Microsoftin kanssa ns. 

Software Assurance –sopimus. 

Hinnoittelu:  

https://powerbi.microsoft.com/en-us/pricing/  

Perusteellisempi hinnoittelumallin kuvaus: 

Power BI – hinnat ja lisenssit | HExcelligent.fi 

 

  

https://powerbi.microsoft.com/en-us/pricing/
https://hexcelligent.fi/2021/10/10/power-bi-hinnat-ja-lisenssit-v2/
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Power BI Desktop (PBI Desktop) 

Datan latauksen, tietomallin ja laskentalogiikan toteuttaa usein teknisesti 

taitava kontrolleri, analyytikko tai BI-asiantuntija, joka tuntee yrityksen 

tietojärjestelmiä, dataa ja dataan liittyviä prosesseja riittävän hyvin.  

Yksinkertaisia kertaluonteisia täsmäraportteja oppii tekemään kuka 

tahansa, jos data on riittävän esivalmisteltua ja raportointiin soveltuvaa. 

© Datan lataus ja muokkaus tehdään PBI Desktopissa olevalla Power 

Query -editorilla. Power Queryssä on yli 300 erilaista datan 

muokkaustoimintoa, kuten sarakkeiden pilkkominen osiin, 

tietotyyppien muuntaminen, tiedon kääntäminen, merkkien 

korvaaminen toisella, jne. Power Query nauhoittaa datalla suoritettuja 

operaatioita ja muodostaa niistä M-kielistä koodia. 

 

© Tietomallin laatiminen tarkoittaa ladattujen taulujen yhdistämistä 

toisiinsa jonkun yksilöivän id-tiedon perusteella, kuten esimerkiksi 

tuotenumeron. Tietomallin laatimiseen liittyy myös esimerkiksi 

erilaisten sarakkeiden luokittelu maantieteellisiksi kentiksi, jotta lukuja 

voi visualisoida karttoina.  

 

Power BI -raportointi toimii ja skaalautuu parhaiten, jos on mahdollista 

luoda ns. dimensionaalinen tähtimalli. Yksinkertaisissa itsepalvelu-

tyyppisissä täsmäraporteissa saattaa riittää yksinkertaisempikin 

tietorakenne, mutta dataa yhdistelevissä raportointiratkaisuissa tulisi 

aina pyrkiä tähtimalliin. Lisätietoja tähtimallista: 

 

https://www.sqlbi.com/blog/marco/2017/10/02/why-data-modeling-

is-important-in-powerbi/ & 

https://docs.microsoft.com/en-us/power-bi/guidance/star-schema  

 

© Laskentalogiikka toteutetaan tietomallissa DAX-kielellä. Kaavoja 

kutsutaan mittareiksi (measures) tai lasketuiksi sarakkeiksi (calculated 

columns). Lisäksi DAX-kielellä voi luoda tietomalliin uusia tauluja, jos 

niitä halutaan johdatella esimerkiksi olemassa olevista tauluista. 

 

 

https://www.sqlbi.com/blog/marco/2017/10/02/why-data-modeling-is-important-in-powerbi/
https://www.sqlbi.com/blog/marco/2017/10/02/why-data-modeling-is-important-in-powerbi/
https://docs.microsoft.com/en-us/power-bi/guidance/star-schema
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© Visualisointeja ja raporttisivuja on helppo laatia ja oikein laaditun 

tietomallin päälle laaditut raporttisivut ovat automaattisesti 

vuorovaikutteisia. Esimerkiksi raporttisivulla olevan palkkikaavion 

palkin napsautus vaikuttaa siihen, mitä muissa saman raporttisivun 

visualisoinneissa näytetään. PBI:n omien visualisointien lisäksi 

raporttitiedostoihin voi ladata käyttöön mukautettuja visualisointeja 

(custom visuals): 

 

https://store.office.com/en-us/appshome.aspx?productgroup=PowerBI.  

 

 Tiedoksi 

 

Vuodesta 2019 lähtien, kyselyitä on voinut luoda myös 

selainpohjaisella Power Queryllä pilvipalvelussa.  

 

Keskitetysti pilvipalveluun luotuja kyselyitä kutsutaan tietovuo 

taulukoiksi (dataflow tables).  

 

Isommissa organisaatioissa keskitetyt raportointiratkaisut perustuvat 

usein tietovarastoissa (dw) oleviin tauluihin. Tietovuo-tekniikan avulla 

vastaavia keskitettyjä tauluja voi luoda Power BI -pilvipalveluun. 

Lisätietoja: https://docs.microsoft.com/en-us/power-bi/service-

dataflows-overview.  

 

Peruskurssilla ei käsitellä tietovuotaulukoita, joten perehdy niihin 

omatoimisesti, mikäli olet kiinnostunut keskitetyistä kyselyistä. 

 

  

https://store.office.com/en-us/appshome.aspx?productgroup=PowerBI
https://docs.microsoft.com/en-us/power-bi/service-dataflows-overview
https://docs.microsoft.com/en-us/power-bi/service-dataflows-overview
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Power BI –pilvipalvelu 

Pilvipalveluun luodaan työtiloja (workspaces), joihin raporttitiedostot 

tallennetaan eli julkaistaan (publish). 

Julkaistuista raporttitiedostoista voi laatia pilvipalvelussa ns. 

koontinäyttöjä (dashboards). Koontinäyttöihin voi koota visualisointeja 

useista eri raporteista. Esimerkiksi johtoryhmälle voisi toteuttaa 

koontinäytön, josta he voisivat yhdellä silmäyksellä nähdä oleellisimpia 

tunnuslukuja tarvitsematta siirtyä raportilta toiselle. Power BI Report 

Server -ympäristössä ei ole koontinäyttöjä. 

Pilvipalvelussa on runsaasti erilaisia toiminnallisuuksia, kuten datan 

automaattinen ajastettu päivitys. 

Raportteja tai koontinäyttöjä voi jakaa käyttäjille (share) yksittäin tai 

niistä voi luoda eli julkaista pilvipalvelussa ns. sovelluksia (publish apps). 

Jakamisen tai sovelluksen julkaisemisen yhteydessä annetaan 

käyttöoikeuksia, jotta muut voivat tarkastella raportteja.  

Power BI –pilvipalvelussa on tällä hetkellä 01/2022 viisi erilaista 

jakovaihtoehtoa. Organisaation koko, raporttien määrä ja käyttäjämäärä 

vaikuttavat siihen, mitä jakovaihtoehdoista halutaan käyttää. 

Käytetäänpä mitä tahansa jakotekniikkaa, tarvitaan riittävät lisenssit. 

Premium-kapasiteettilisenssimallilla raportteja voi jakaa myös käyttäjille, 

joilla ei ole henkilökohtaisia maksullisia. Jos Premium-kapasiteettilisenssiä 

ei ole, raporttien katsojilla pitää aina olla joko Pro tai Premium Per User -

lisenssi. Pro-lisenssillä jaettuun raporttia pääsee katsomaan Pro-lisenssillä 

ja Premium per User -lisenssillä jaettua raporttia pääsee katsomaan vain 

Premium per User -lisenssillä. 

1. Raportin jakaminen julkisesti maailmalle  

joko jaettavan linkin tai nettisivuille upotettavan koodin avulla. Julkista 

jakamista voi tehdä myös ilmaislisenssillä. Muut jakovaihtoehdot 

edellyttävät maksullisen lisenssin. Julkinen jakaminen on nykyisin 

oletusarvoisesti otettu pois käytöstä Power BI pilvipalvelusta. Jos sinun 

pitää julkaista raportteja nettiin, kysy oman organisaatiosi Power BI -

pääkäyttäjältä, onko se teillä mahdollista ja kenellä on oikeus luoda 
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julkisia upotettavia linkkejä. 

 

2. Raportin jakaminen hallitusti käyttöoikeuksiin perustuen 

organisaation sisäisille tai ulkopuolisille käyttäjille  

Jaettavat raportit voivat sijaita joko henkilökohtaisissa työtiloissa tai 

työryhmien käytössä olevissa työtiloissa (workspaces).  

 

3. Koontinäyttöjen (dashboards) jakaminen joko organisaation 

sisäisille tai organisaation ulkopuolisille käyttäjille.  

Jaettavat koontinäytöt voivat sijaita joko henkilökohtaisissa työtiloissa 

tai raportointityöryhmien käytössä olevissa työtiloissa (workspaces). 

Jälkimmäinen on organisaatiokäytössä suositeltavampi. Kun 

koontinäyttö jaetaan, samalla jaetaan lukuoikeus kaikkiin niihin 

raportteihin, joista on kiinnitetty ruutuja koontinäytölle.  

 

4. Työtiloista muodostuvien kokonaisuuksien julkaiseminen ns. 

paketoituina sovelluksina (apps).   

Kun Power BI -työtilan sisällöstä julkaistaan sovellus, sovellukseen voi 

toteuttaa halutun valikkorakenteen. Valikkoon voi lisätä myös Power 

BI pilvipalvelun ulkopuolisia linkkejä. Sovellusten käyttäminen on 

erittäin suositeltava jakelutekniikka erityisesti isommissa 

organisaatioissa ja isompien raporttikokonaisuuksien jakamiseen. 

Lisätietoja: https://docs.microsoft.com/en-us/power-

bi/consumer/end-user-apps  Raportointipalvelimella ei ole ns. 

sovelluksia. 

 

5. Jakamisen voi suorittaa myös siten, että käyttäjille annetaan 

lukuoikeus tarkastella sisältöä suoraan työtiloissa (workspace), 

joissa raportoinnin kehittäjät toteuttavat raportointia.  

Jakamisen eli käyttöoikeuksien antamisen jälkeen sisältöä voi upottaa 

erilaisiin sijainteihin, joissa käyttäjät hyödyntävät raportteja.  

Käyttäjät eivät siis välttämättä hyödynnä raportteja Power BI -pilvipalvelun 

käyttöliittymässä, vaan esimerkiksi upotettuina julkisilla nettisivustoilla, 

SharePoint-sivustoilla, intrassa, Teams-kanavissa tai PowerApps -

https://docs.microsoft.com/en-us/power-bi/consumer/end-user-apps
https://docs.microsoft.com/en-us/power-bi/consumer/end-user-apps
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applikaatioissa. Sovelluskehittäjät ovat myös voineet toteuttaa sovelluksia, 

joihin raportteja ja/tai koontinäyttöjä on upotettu. 

Pilvipalvelussa on jakamisen lisäksi runsaasti erilaisia toimintoja, joita 

käyttäjät sekä kehittäjät voivat hyödyntää, kuten muodostaa raportista 

PowerPoint-esityksen tai kytkeytyä ja tehdä datasta esimerkiksi Excelissä 

pivot-taulukoita.  

Pilvipalvelulisenssit 

Hinnoittelu 

© ilmainen Power BI Free 

on henkilökohtaiseen käyttöön tai täysin julkiseen jakamiseen 

tarkoitettu, sillä raportteja ei voi jakaa organisaation sisällä free-

lisenssillä 

© maksullinen käyttäjäkohtainen Power BI Pro, joka maksaa noin 8,5 € 

per henkilö per kuukausi (pienemmille noin alle 550 henkilön 

organisaatioille), 

© maksullinen Power BI Premium, joka maksaa alkaen 4200 € per kk 

(isommille noin yli 550-600 henkilön organisaatioille).  

© Kesällä 2021 julkistettu käyttäjäkohtainen Premium Per User, joka 

maksaa noin 17 € per käyttäjä per kk. Tämän uuden lisenssimallin 

avulla myös pienemmillä yrityksillä on mahdollista saada ”järeämpi” 

Power BI lisäominaisuuksineen tarvitsematta ostaa yli 4000 €/kk 

hintaista Premium-lisenssiä. 

 

Lisäksi on tarjolla sovelluskehitykseen eli upottamiseen soveltuvia 

lisenssejä (EM1-EM3, A1-A6) 

Voit tarkistaa eri lisenssien erot sekä hinnat Microsoftin sivuilta 

(https://powerbi.microsoft.com/en-us/pricing/).  

Muita lisätietoja lisensseistä: Power BI – hinnat ja lisenssit | HExcelligent.fi 

Omassa konesalissa oleva Power BI raportointipalvelin 

Raportointipalvelimella (Report Server) raporttitiedostoja tallennetaan 

kansioihin, joihin käyttäjille annetaan oikeuksia. Raportointipalvelimella ei 

https://powerbi.microsoft.com/en-us/pricing/
https://powerbi.microsoft.com/en-us/pricing/
https://hexcelligent.fi/2021/10/10/power-bi-hinnat-ja-lisenssit-v2/
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ole olemassa koontinäyttöjä ja ominaisuudet ovat muutenkin vähäisempiä 

pilvipalveluun verrattuna.  

Myös raportointipalvelimella datan voi päivittää ajastetusti.  

Selvitä oman organisaatiosi käytännöt, jos teillä käytetään 

raportointipalvelinta tai mahdollisesti sekä pilvipalvelua että 

raportointipalvelinta. 

Power BI mobiilisovellus 

Power BI -raportteja, koontinäyttöjä ja sovelluksia voi käyttää myös 

Microsoft Power BI mobiilisovelluksella. 

Kehittäjä voi toteuttaa jokaisesta raporttisivusta ja koontinäytöstä 

mobiilinäkymän. Raporttien mobiilinäkymät toteutetaan Power BI Desktop 

-ohjelmassa ja koontinäyttöjen mobiilinäkymät pilvipalvelussa. 

Idea on se, että käyttäjä näkee alkuperäisen näkymän, kun hän tarkastelee 

raporttia vaakasuuntaisesti käännetystä mobiililaitteesta. Kun käyttäjä 

kääntää laitteen pystyyn, tilalle vaihtuu kehittäjän laatima mobiilinäkymä. 
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Tutustu oman organisaatiosi Power BI -käytäntöihin ja ohjeisiin 

Kun ryhdyt käyttämään Power BI:tä, selvitä oman organisaatiosi käytännöt. 

Isommissa organisaatioissa Power BI:n käyttöön liittyy usein erilaisia 

ohjeita ja suosituksia.  

© Onko olemassa brändin mukainen teemaväritiedosto, jonka voi ladata 

Power BI -tiedostoihin? 

© Onko olemassa Power BI -mallitiedostoja (template)? 

© Onko Teams/Yammer tms. ryhmiä, joissa voi keskustella, kysyä ja jakaa 

Power BI -raportointiin ja esimerkiksi tietolähteisiin liittyviä tietoja? 

© Mitä tietolähteitä suositellaan käytettäväksi, ketkä niistä vastaavat ja 

miten niihin saa käyttöoikeuksia? 

© Mihin pilvipalvelun työtiloihin tai raportointipalvelimen kansioihin 

raportteja on tarkoitus julkaista? 

© Suositellaanko pilvipalvelussa luomaan ns. keskitettyjä tietomalleja 

(datasets) ja luodaanko raportit niiden pohjalta erillisiin Power BI 

raporttitiedostoihin? Toteutetaanko kyselyt Power BI Desktop -

tiedostoissa vai käytetäänkö keskitettyjä tietovarasto (DW) tai 

pilvipalveluun luotuja tietovuo-tauluja (dataflow tables)? 

 

 Verkostoituminen ja tiedon jakaminen kannattaa 

 

Power BI -tuote on laaja, monipuolinen, aktiivisesti kehittyvä ja 

muuttuva, joten kannattaa mahdollisuuksien mukaan verkostoitua 

sekä oman organisaation Power BI -käyttäjien että mahdollisesti 

laajemminkin Power BI -käyttäjien kanssa. 

 

Toteuta mahdollisuuksien mukaan raportteja yhdessä kollegoiden 

kanssa toisiltanne oppien. 
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2 Power BI Desktopin asennus ja asetukset 

2.1 Power BI Desktop – tavallinen versio 

 

Pilvipalvelun kanssa käytettävästä Power BI Desktopista tulee 

uusi versio kuukausittain. Voit asentaa sen muutamalla eri 

tavalla. Selvitä oman organisaatiosi asennustapa. Power BI 

Desktopista ei ole olemassa Mac-versiota. 

1. Microsoftin kaupasta (Store) 

Asentamalla sen Microsoft kaupan kautta 

(https://www.microsoft.com/en-us/store/p/power-bi-

desktop/9ntxr16hnw1t), se päivittyy jatkossa automaattisesti 

kuukausittain eikä sinun tarvitse itse päivittää sitä.  

 

2. Latauskeskuksesta (download center) 

Lataa ja asenna se itse kuukausittain (mieluiten 64-bittinen versio) 

Microsoftin latauskeskuksesta (Download Center): 

 

https://www.microsoft.com/en-us/download/details.aspx?id=58494  

 

Pyydä asennukseen apua IT:ltä, jos oikeutesi eivät riitä.  

 

Power BI Desktopin oikeaan alakulmaan tilariville ilmestyy PÄIVITYS 

SAATAVILLA (UPDATE AVAILABLE) –teksti, kun uusi versio on 

julkistettu. Asenna uusi kuukausittain. 

 

 Organisaatiossasi PBI Desktop asennetaan mahdollisesti 

automatisoidusti tai sinun pitää asentaa se teidän sisäisestä 

sovellusten jakelukeskuksesta. 

 Jos olet asentanut PBI Desktopin työasemaasi sekä latauskeskuksesta 

että kaupasta, poista Windowsin ohjauspaneelissa (control panel) 

näkyvä PBI Desktop -versio (latauskeskuksesta asennettu) jottei 

työasemassasi ole kahta eri versiota, joista vain toinen päivittyy 

automaattisesti. 

https://www.microsoft.com/en-us/store/p/power-bi-desktop/9ntxr16hnw1t
https://www.microsoft.com/en-us/store/p/power-bi-desktop/9ntxr16hnw1t
https://www.microsoft.com/en-us/download/details.aspx?id=58494
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2.2  Power BI Desktop – Report Server versio 

 

Power BI Report Serverin kanssa pitää käyttää serveriversion 

kanssa yhteensopivaa Power BI Desktop optimized for 

Report Server -versiota. 

Selvitä omasta IT:stä mitä versiota käytätte ja miten saat sen omaan 

työasemaasi. Huomaa, että yhteensopimattomalla Power BI Desktop -

versiolla tehdyt raportit eivät toimi raportointipalvelimella eikä niitä 

välttämättä pysty konvertoimaan oikeaan muotoon helposti. 

2.3 Kieliasetukset 

Sovelluksen kieli (application language) 

 

Pilvipalvelun kanssa käytettävän Power BI Desktop -

ohjelman kielen voi vaihtaa. Sen voi tehdä milloin tahansa. 

Vaihdat käyttöliittymän kielen komennolla File > Option and Settings > 

Options > ikkunassa oleva ylempi Regional Settings komento 

(Tiedosto > Asetukset ja vaihtoehdot > Valinnat > ikkunassa oleva ylempi 

Aluekohtaiset asetukset -komento). Mikäli PBI Desktopista ei löydy kielen 

vaihtokomentoa, sinulla on vanha ns. .msi -paketilla asennettu versio 

työasemassasi. Asenna uusi versio, jotta pystyt vaihtamaan kieltä. 

Mallin kieli (model language) 

 

Jos datasi sisältää tyypillisesti ääkkösiä (kuten suomenkielisiä 

nimiä), PBI Desktopin asetuksista pitää valita mallin kieleksi 

(model language) suomi. Tällöin ääkköset aakkostuvat 

raporteissasi oikein.  

 

Mallin kieli on pitänyt valita ennen tiedoston luontia eikä sitä 

pysty vaihtamaan jälkeenpäin. 
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Jos valitset suomenkielisen käyttöliittymän, ikkunassa on vielä yksi valinta, 

joka vaikuttaa Power Queryn nauhoituskieleen. Ks. seuraava sivu. 

 

Power BI Report Serverin kanssa käytettävän Desktop-

version mallin kieltä ei pysty vaihtamaan. Mallin kieli 

määräytyy käyttöliittymäkielen perusteella eli sen perusteella 

minkä kielinen Desktop on asennettu työasemaan. 
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Suomenkielisen version käyttäminen kansainvälisessä organisaatiossa 

Jos työskentelet kansainvälisessä organisaatiossa, mutta haluat itse käyttää 

suomenkielistä PBI Desktop –versiota ja muiden kuin suomenkielisten 

pitää pystyä muokkaamaan laatimaasi mallia, vaihda suomenkielisessä PBI 

Desktopissa seuraava asetus ennen kuin ryhdyt luomaan Power Query 

kyselyitä, jotta kyselyiden vaiheet muodostuvat englanninkielisinä 

askeleina: 

 

Tiedosto > Asetukset ja vaihtoehdot > Valinnat > Aluekohtaiset 

asetukset > Aina englanti ja sulje vielä kerran Power BI Desktop ennen 

kuin ryhdyt tekemään ensimmäistä raporttitiedostoa. Tällä estetään se, 

että erilaiset kyselyitä kuvaavat vaiheet (step) tulisivat suomen kielellä.   

Power Queryn oletuskansallisuusasetus 

Kun luet Power Queryllä dataa, Power Query olettaa lukujen olevan 

työaseman kansallisuusasetusten mukaisessa muodossa. Yleensä 

suomalaisessa työasemassa Power Query olettaa luvuissa käytetyn 

desimallipilkkua sekä tuhaterottimena välilyöntiä, mutta voit kussakin 

kyselyssä määrittää kunkin sarakkeen kansallisuuden. 

Jos datasi on pääasiassa muunlaista kuin Power Query olettaa sen olevan 

ja haluat helpottaa kyselyiden laatimista, voit vaihtaa latauksen yhteydessä 

käytetyn kansallisuusoletuksen Asetukset (Options) -ikkunasta.  

DAX-kaavojen kansallisuus 

Kesästä 2020 lähtien on voinut myös määrittää mitä erottimia käytät DAX-

kaavoissa. Erottimet voivat olla joko vakioitu yhdysvaltalaisiksi tai ne voivat 

määräytyä lokaalisti työasemasi Windows-asetuksista. Oletuksena on 

nykyisin yhdysvaltalaiset asetukset eli pilkku argumenttierottimena. 

=CALCULATE ( argumentti1, argumentti2) // pilkku erottimena 

=CALCULATE (argumentti1; argumentti2) // puolipiste erottimena 

Asetuksen voi vaihtaa milloin tahansa. 
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3 PBI Desktopin käyttöliittymä 

PBI Desktopilla luodaan kyselyt sekä laaditaan tietomalli, jossa yhdistetään 

eri tauluja. Tietomalliin tehdään myös luokitteluita, lajittelujärjestyksiä, 

hierarkioita sekä lisätään kaavoja, kuten mittareita (measures).  

Usein myös visualisoinnit eli raportit luodaan PBI Desktopissa, vaikka niitä 

voikin luoda myös pilvipalvelussa. 

Huomaa, että kaikkia edellä mainittuja ei välttämättä tehdä samaan PBI 

Desktop -tiedostoon, jos halutaan toteuttaa keskitetympiä 

raportointiratkaisuita ja raportointia on toteuttamassa useampia 

henkilöitä. Ks. arkkitehtuuri sivulta 109.  

 

Jos teidän organisaatiossa raportointi on vahvasti IT:n ohjaamaa ja 

raporttien tietolähteenä on esimerkiksi SQL Serverin Analyysipalvelimen 

tabular-malli tai -kuutio, Power BI:stä otetaan vain yhteys malliin ja 

tehdään visualisoinnit. Tiedon mallinnus ja laskenta on tällöin tehty jo 

valmiiksi analyysipalvelimen malliin. Kysy tällöin tarkempia ohjeita mallien 

käytöstä IT:stä.  

Lisätietoja: https://docs.microsoft.com/en-us/power-bi/desktop-analysis-

services-tabular-data 

 

 

https://docs.microsoft.com/en-us/power-bi/desktop-analysis-services-tabular-data
https://docs.microsoft.com/en-us/power-bi/desktop-analysis-services-tabular-data
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3.1 Power BI Desktop verrattuna Excelin Power-työkaluihin 

Power BI Desktopin työkalut kehitettiin alkujaan Exceliin.  

© Power Query datan lataamiseen, muokkaamiseen ja muuntamiseen, 

 

 
 

© Power Pivot & DAX-kieli tiedon mallintamiseen ja laskentaan, 

 

 
 

© Power View -kaaviot, joita ei enää edes ole Excelissä ja jotka ovat 

saaneet täydellisen kasvojenkohotuksen Power BI Desktopissa. Power 

View -kaaviot olivat eräänlainen Power BI -raporttien esiversio. 
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4 Power Query -kyselyeditori 

Dataa ladataan ja muokataan Power Query -kyselyeditorissa, joka 

käynnistyy uuden kyselyn luonnin yhteydessä komennolla Home > Get 

Data (Nouda tiedot). Kyselyitä pääsee muokkaamaan Power Queryyn 

esimerkiksi komennolla Home > Transform data (Aloitussivu > Muunna 

tiedot). 

 

Kun kyselyt on tehty ja data on ladattu PBI-tiedostoon, data päivitetään 

Home > Refresh (Aloitussivu > Päivitä) -komennolla.  

Pilvipalveluun julkaisemisen jälkeen päivityksen voi ajastaa pilvipalvelussa 

(schedule refresh). Joidenkin tietolähteiden ajastus pilvipalvelussa 

edellyttää, että IT on asentanut ympäristöönne ns. gateway-palvelun, joten 

selvitä ajastusmahdollisuudet oman organisaation IT:ltä.  

Tiedoksi: Myös pilvipalvelussa voi luoda ns. keskitettyjä Power Query -

kyselyitä ja siellä niitä kutsutaan tietovuo-tauluiksi (dataflow entities). 
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4.1 Kaavarivi Power Queryssä 

Kun ryhdyt toteuttamaan ensimmäistä kyselyä ja Power Query avautuu, 

tuo Power Queryn kaavarivi esiin komennolla View > Formula bar (Näytä 

> Kaavarivi).  

Tulet tarvitsemaan kaavariviä kyselyiden tarkastelun ja muokkauksen 

yhteydessä. Kaavarivistä on hyötyä erityisesti erilaisten ongelmatilanteiden 

selvittelyn yhteydessä. 
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4.2 Kyselyn laatiminen ja tyypillisimmät operaatiot 

1. Aloita uuden kyselyn luonti Home > Get Data (Aloitus > Nouda 

tiedot) tai Home > Recent Sources (Aloitus > Viimeaikaiset lähteet) –

toiminnolla.  

2. Valitse tietolähde, syötä tarvittaessa käyttäjätunnuksesi ja anna muut 

tarkemmat tietolähderiippuvaiset tiedot.  

3. Kun olet antanut tarvittavat tiedot, käynnistä Power Query Transform 

Data (Muokkaa tietoja) –painikkeella.  

 

Vaikka ikkunassa on keltaisella korostettuna Load (Lataa) -painike, älä 

käytä sitä. Yleensä sinun pitää suorittaa joitakin toimenpiteitä datalle, 

kuten määrittää sarakkeiden tietotyypit, joten lähes aina tulisi siirtyä 

Power Queryyn suoran latauksen sijaan. 

 

Transform Data (Muokkaa tietoja) -painikkeen jälkeen Power Query -

ikkunan pitäisi aktivoitua.  

 

4. Suorita Power Queryssä tarpeelliset toiminnot, joihin kuuluu yleensä 

vähintään: 

© tarpeettomien sarakkeiden poistaminen, 

© ylimääräisten rivien suodattaminen pois, 

© otsikoista huolehtiminen, 

© sarakkeiden tietotyyppien (luku, teksti, päiväys, jne) 

määrittäminen,  

© muita tarvittavia datan muokkaustoimenpiteitä. 

 

Kun suoritat erilaisia datan muokkausoperaatioita, Power Query 

nauhoittaa niistä askeleita (step) oikealla näkyvään paneeliin. 

Seuraa mitä paneelissa tapahtuu ja mitä sinne muodostuu.  

 

Kukin toimenpide näkyy askeleena (step), mutta tietyt peräkkäiset 

toimenpiteet saattavat muodostaa yhden askeleen. Joskus 

puolestaan yksi suoritettu toimenpide voi aiheuttaa useita 

askeleita.  

 



 

Power Query -kyselyeditori 

 

   Sivu 24    

5. Anna kyselylle kuvaava nimi. Nimi syötetään esimerkiksi oikealla 

näkyvään Query Settings (Kyselyasetukset) -paneeliin, johon Power BI 

Desktop on jo ehdottanut jotain nimeä. 

6. Kun lopputulos näyttää halutulta, sulje Power Query ja suorita kysely 

eli datan kopiointi PBI-tiedostoon komennolla Home > Close & 

Apply (Sulje ja ota käyttöön). 

Kyselyn tulosjoukosta muodostuu taulu ja se ilmestyy PBI Desktop 

pääikkunan vasemmassa reunassa oleviin Model (Malli)- ja Data (Tiedot) -

näkymiin.  

Tulostaulukko näkyy myös oikeassa reunassa Fields (Kentät) -listassa.   

 

 

Yksinkertaisimmassa raportointitilanteessa voit ryhtyä samantien 

tekemään raportteja. 

Jos haluat tehdä muutoksia kyselyyn, siirry takaisin kyselyeditoriin 

esimerkiksi Home > Transform data (Aloitussivu > Muunna tiedot) –

painikkeella tai valitse oikealla taulun päältä pikavalikosta komento Edit 

Query (Muokkaa kyselyä). 
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4.3 Power Queryn käyttöliittymä 

 

(A) Vasemmalla Queries (Kyselyt) -paneelissa on kaikki kyselyt sekä 

esimerkiksi parametrit. Paneelin avulla voi siirtyä kyselystä toiseen sekä 

suorittaa kyselyille pikavalikoiden avulla erilaisia operaatioita. Voit 

ryhmitellä kyselyitä eri kansioihin (group). 

(B) Power Queryn "esikatselussa" näytetään vain osa riveistä. Joskus tämä 

esikatselu muodostuu vanhasta välimuistissa olevasta datasta, jos olet 

muokkaamassa aiemmin luotua kyselyä. Jos epäilet, että esikatselu näyttää 

sinulle vanhentunutta tietoa, päivitä esikatselun Refresh Preview (Päivitä 

esikatselu) -painikkeella. 

(C) Kun haluat tarkastella tietyn solun sisältöä merkki merkiltä, valitse solu, 

jolloin alaosaan tulee esiin tarkasteluruutu. Kuljet tarkasteluruudussa 

nuolinäppäimillä, jos sinun pitää esimerkiksi tutkia onko merkkijonon 

alussa tai lopussa turhia välilyöntejä tai laskea merkkijonon merkkien 

lukumäärää. 
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(D) Oikealla Query Settings (Kyselyasetukset) paneelissa 

(1) annetaan kyselylle nimi sekä kirjoitetaan lyhyt kuvaus (All 

Properties, Kaikki ominaisuudet) 

(2) tarkastellaan, muokataan ja poistetaan kyselyn askeleita 

(steps). 

(E) Jokainen askel (step) on M-kielinen funktio ja paneelista valitun 

vaiheen funktio näkyy kaavarivillä, jos olet tuonut kaavarivin esiin 

komennolla View > Formula bar (Näytä > Kaavarivi). Kaavarivin on hyvä 

olla esillä, sillä siitä on hyötyä. 

(F) Valmis muokattu aineisto ladataan Power BI -tietomalliin Close & 

Apply (Sulje ja ota käyttöön) -painikkeen vaihtoehdoilla. Kaikkien 

kyselyiden tulosta ei aina ladata tietomalliin, vaan osa kyselyistä saattavat 

olla erilaisia apukyselyitä. Tästä syystä Queries (Kyselyt) -paneelissa 

kyselyn nimen päältä avautuvasta valikoista löytyy myös komentoja, jotka 

estävät kyselyn tuloksen latautumisen tietomalliin. 

Kysely näkyy oikealla askeleina. Jos haluat saada esiin M-kielisen koodin 

kokonaisuudessaan, voit tarkastella koodia Home > Advanced Editor 

(Aloitus > Laajennettu editori) -ikkunassa.  

4.4 Tyypillisimpiä kyselyn vaiheita 

Tarpeettomien sarakkeiden poistaminen 

 

Poista tarpeettomat sarakkeet 

joko pikavalikon komennoilla tai 

käytä valintanauhassa olevia 

painikkeita. 
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Rivien suodattaminen 

Rivejä ei voi poistaa valitsemalla niitä ja sen jälkeen pikavalikosta, vaan 

rivejä esimerkiksi suodatetaan pois. 

Suodatat rivejä kuten Excelissä eli käyttämällä sarakeotsikoissa olevia 

suodatusnuolia tai käytä Home (Aloitus) –välilehdeltä löytyviä rivien 

poistopainikkeita. Suodatus vaikuttaa ladattavan datan määrään. 

 

Suodatuslistalla ei välttämättä näytetä kaikkia arvoja, jos niitä on paljon. 

Tällöin suodatuspaneelin alaosassa on linkki (load more), jolla voit ladata 

luetteloon lisää arvoja. 

Otsikot kuntoon 

Jos otsikot eivät ole nousseet otsikoiksi vaan näkyvät ensimmäisenä 

tietorivinä, voit nostaa ne otsikoiksi komennolla Home > Use first row as 

headers (Aloitus > Käytä ensimmäistä riviä otsikkoina). 

Mikäli otsikoiden yläpuolelta pitää poistaa ylimääräisiä tyhjiä rivejä, käytä 

komentoa Home > Remove Rows > Remove Top Rows (Aloitus > 

Pienennä rivejä > Poista rivit) ja syötä poistettavien rivien määrä tai 

suodata turhat rivit pois sarakeotsikoissa olevien suodatusnuolten avulla. 

Pääset muokkaamaan otsikkotekstejä kaksoisnapsauttamalla niitä 

otsikkorivillä. 
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Sarakkeiden tietotyyppien määrittäminen 

 

Yksi tärkeimmistä kyselyeditorin 

toimenpiteistä on määrittää 

sarakkeiden tietotyypit, jotta luvut 

ymmärretään tietomallissa lukuina 

ja esimerkiksi päivämäärät 

päivämäärinä. 

 

Jos sarakeotsikon edessä on 

symboli ABC (teksti) tai 

sekasymboli ABC123 (tietotyyppiä 

ei ole määritetty), mutta sarakkeen 

pitäisi olla joko numero tai 

esimerkiksi päivämäärä, valitse 

oikea tietotyyppi napsauttamalla 

symbolia. 

 

Jos luvuissa on käytetty yhdysvaltalaisittain desimaalipisteitä, valitse 

alimmainen Using Locale (Käytetään aluekohtaisia asetuksia) -komento ja 

valitse seuraavat vaihtoehdot: 
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Power Queryssä määritetään vain tietotyyppi, muttei oteta kantaa tietojen 

muotoiluun. Muotoilut määritetään Power BI Desktopin pääikkunassa 

vasta tietojen lataamisen jälkeen. 

Joskus Power Query tulkitsee tietotyyppejä virheellisesti, kuten 

postinumeroita numeroiksi, jolloin niistä poistuu etunollat. Valitse ensin se 

vaihe (step), jossa virhe on tapahtunut ja vaihda tietotyyppi halutuksi, 

kuten tekstiksi.  

Huomaa, että Power Query tulkitsee tietotyypit vain 200 ensimmäisen rivin 

perusteella. Joskus se saattaa tulkita sarakkeen numeroiksi, jos 200 

ensimmäistä riviä sisältää vain numeroita. Jos alempana on myös 

tekstisoluja, ne muuttuvat virheiksi (error). On tärkeää, että tiedät, millaista 

tietoa sarakkeissa oikeasti on, jotta pystyt määrittämään tietotyypit oikein. 

Mikäli saat kyselyn suorituksen jälkeen ilmoituksen virheistä, väärät 

tietotyypit ovat virheiden yleisin syy.  

Ks. datavirheet sivulta 32 
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Virheet 

Power Queryssä ei ole Undo (Kumoa) -painiketta.  

Jos muodostat turhan tai virheellisen vaiheen, poistat sen vaiheen edessä 

olevalla rastilla. Jos haluat muokata vaihetta, napsauta joko vaiheen 

oikealla puolella näkyvää ratasta tai muokkaa kaavarivillä näkyvää kaavaa, 

jos ratas ei ole käytettävissä. 

 

 

 

Ole varovainen kaavoja muokatessasi, sillä kyselyeditorin M-kieli on 

kirjainkokoriippuvainen. Kaavoissa pitää käyttää oikean kokoisia isoja tai 

pieniä kirjaimia.  
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4.5 Kyselyn muokkaus 

Jos haluat lisätä kyselyyn uuden askeleen, valitse ensin se vaihe, jonka 

jälkeen haluat muodostaa uuden askeleen. Huomaa että muutosten 

tekeminen keskelle kyselyä saattaa aiheuttaa, että jokin myöhempi vaihe ei 

enää toimi. Muutosten jälkeen saatat joutua muokkaamaan myös kyselyn 

loppuosaa. 

 

 Tietotyypin muuttaminen kyselyssä 

Tietotyypin muutos pitää yleensä tehdä sen askeleen (step) kohdalla, 

jossa virhe on tapahtunut. Jos esimerkiksi sarakkeen tietotyypiksi 

määritetään kokonaisluku, mutta sarakkeessa on tekstiä, kaikki 

tekstisolut ovat muuttuneet virheilmoituksiksi eikä niitä voi enää 

myöhemmässä vaiheessa korjata tekstiksi. Jos solun sisältö on 

muuttunut virheeksi, sen alkuperäistä arvoa ei enää tiedetä.  

 

Etsi kyselystä se kohta, jossa tietotyyppi vaihtuu vääräksi, valitse vaihe 

ja muuta tietotyyppi esimerkiksi tekstiksi.  

 

Huomaa, että joskus kyselyssä voi olla useita tietotyyppiä muuttavia 

vaiheita, sillä tietyt komennot luovat niitä puolestasi automaattisesti. 
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4.6 Kyselyn suoritus eli datan lataus tietomalliin 

Niin kauan, kun olet vielä kyselyeditorissa, sinulle näytetään datasta vain 

esikatselu. 

Kun kysely on valmis ja haluat ladata kyselyt fyysisiksi tauluksi PBI Desktop 

-tiedostoon, valitse Close & Apply (Sulje ja ota käyttöön). 

4.7 Datan päivitys 

 

Kun data on ladattu PBI Desktop -

tiedostoon, voit päivittää kaikkien 

kyselyiden tiedot valitsemalla Home > 

Refresh (Aloitus > Päivitä). Jos haluat 

päivittää vain yhden taulun, valitse 

kyselyn eli taulun nimen päältä 

pikavalikosta Refresh data (Päivitä 

tiedot). 

Datan automaattisen päivityksen voi ajastaa sekä pilvipalvelussa että 

raportointipalvelimella. 

4.8 Siirtyminen pääikkunasta Power Queryyn 

Kun haluat muokata kyselyä, siirry kyselyeditoriin esimerkiksi Home > 

Transform data (Aloitussivu > Muunna tiedot) –painikkeella tai taulun 

päältä pikavalikosta Edit Query (Muokkaa kyselyä) -komennolla. 

4.9 Tietolähteiden asetukset ja käyttäjätunnukset 

Voit muuttaa tietolähdettä tai siihen liittyviä asetuksia, kuten lähdedatan 

nimeä tai käyttäjätunnusta ja salasanaa komennolla Home > Transform 

data > Data Source Settings (Aloitussivu > Muunna tiedot > 

Tietolähdeasetukset) avautuvasta ikkunasta.  
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4.10 Datan latauksessa virheitä 

Jos kyselyssä tapahtuu virheitä sen suorituksen aikana, saat siitä 

ilmoituksen.  

Virhe voi johtua esimerkiksi siitä, että sarakkeen tietotyypiksi on määritetty 

kokonaisluku, mutta sarakkeessa on myös tekstimuotoista sisältöä.  

 

Napsauta ikkunassa olevaa View errors (Näytä virheet) –linkkiä ja siirry 

sen jälkeen Power Queryyn tutkimaan mitä virheitä datassa on.  

View Errors (Näytä virheet) -painikkeen napsautus muodosti Power 

Queryyn ylimääräisen kyselyn, jonka avulla voit tutkia virheitä.  

Kyselyyn on myös muodostunut sarake, joka kertoo millä rivillä virhe on 

lähdedatassa.  
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Napsauttamalla virhesolun taustaa (ei kuitenkaan keltaista Error-linkkiä) 

näet mitä solussa oli ennen sisällön muuttumista virheeksi. Yllä olevassa 

esimerkkikuvassa tilaustunnukset ovat muuttuneet virheilmoituksiksi, 

koska sarake on määritetty kokonaisluvuiksi, mutta soluissa on myös 

tekstiä (H-kirjain alussa).  

Huomaa, että virhe pitää korjata alkuperäisessä kyselyssä, ei apukyselyssä 

Tutki siis aina mistä virhe aiheutuu, siivoa tai muokkaa tarvittaessa joko 

alkuperäistä lähdedataa tai tee tarvittavat muutokset alkuperäiseen 

kyselyyn, jotta virhe poistuu. Kun olet selvittänyt virheet ja korjannut ne 

alkuperäisissä kyselyissäsi, poista muodostunut Query Errors –kansio 

apukyselyineen.  

Huomaa, että tietotyyppivirheet pitää korjata siinä ensimmäisessä Change 

type (Muutettu tyyppi) -vaiheessa, jossa virhe aiheutuu. Tietotyyppiä ei voi 

korjata enää myöhemmin. 
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4.11 Muita taulujen luontitapoja 

Kyselyiden lisäksi tietomalliin voi luoda tauluja myös muilla tekniikoilla, 

joita opiskellaan perusteellisemmin jatkokurssilla. 

© Tauluja voi luoda komennolla Home > Enter Data (Aloitussivu > 

Anna tiedot) ja joko syöttämällä tai kopioimalla dataa avautumaan 

ikkunaan. 

© DAX-kielellä Modeling > New Table (Mallinnus > Uusi taulukko) 

–komennolla.  
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4.12 Kyselyt: tuonti (import) vai suora yhteys (direct query) 

Power BI -ratkaisu voidaan toteuttaa eri tekniikoilla, joista tuonti (import) 

on yleisimmin käytetty.  

Tuonti (import) 

Kaikkia tietolähteitä voi käyttää siten, että data tuodaan eli se kopioituu 

(import) Power BI tietojoukkoon ja päätyy julkaisun myötä myös 

kokonaisuudessaan pilvipalveluun tai PBI Report Serverille.  

Tällaisia ratkaisuita kutsutaan pilvipalveluympäristössä pilvimalleiksi (cloud 

models), sillä data päättyy pilveen. Jos raportointi halutaan automatisoida, 

datan päivitys pitää ajastaa pilvipalvelussa ja omilla servereillä tai 

levyasemissa olevien tietojen päivitys edellyttää, että IT on asentanut 

ympäristöönne gateway-palvelun. 

Suora yhteys tietokantaan (Direct Query) 

Jotkut (noin 20 tietokantapohjaista tietolähdettä) sallii myös suoran 

yhteyden (Direct Query) –yhteyden, jolloin data pysyy alkuperäisessä 

tietolähteessä ja sitä vain puskuroidaan tarvittaessa raporteille 

näytettäväksi: https://powerbi.microsoft.com/en-

us/documentation/powerbi-desktop-use-directquery/  

Tällaisia malleja kutsutaan ulkoisiksi malleiksi (external models), sillä data 

ei päädy kokonaisuudessaan pilveen. Mallit ovat reaaliaikaisessa 

yhteydessä tietolähteeseen, joten datan ajastettua päivitystä ei tarvita.  

Huomaa, että Direct Query -malleja laativat yleensä keskitetysti sellaiset 

kehittäjät, jotka pystyvät toteuttamaan merkittävän osan ratkaisusta 

tietokannan puolella eli tietolähteessä. Power BI:n ominaisuudet ovat 

rajoitetumpia Direct Query -tilanteessa. 

Yhdistämämalli (Composite model) 

Yhdistelmämalleissa osa tauluista tuodaan (import) ja osaan otetaan suora 

yhteys (direct query). 

 

https://powerbi.microsoft.com/en-us/documentation/powerbi-desktop-use-directquery/
https://powerbi.microsoft.com/en-us/documentation/powerbi-desktop-use-directquery/
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Reaaliaikainen yhteys tabular malliin tai kuutioon (live connection) 

Jos tietolähteenä on SQL Server Analysis Services tai Azure Analysis 

Services tabular-malli tai OLAP-kuutio, siihen voi muodostaa ns. live 

connection -yhteyden.  

Tällöin Power BI:ssä tehdään vain raportit ja visualisoinnit, sillä kaikki 

logiikka on toteutettu analyysipalveluissa. Tabular-mallia käytettäessä voi 

luoda DAX-mittareita, jos on tarpeen.  

 Tällä Power BI perusteet –kurssilla ei perehdytä syvällisesti eri 

yhteyslajeihin ja niiden arkkitehtuuriin, vaan opiskellaan Power BI 

Desktopin käyttöä ja datan tuontia import-tekniikalla.  

 Import-mallissa datan päivityksen yhteydessä oletusarvoisesti kaikki 

rivit ladataan uudelleen malliin. Power BI:ssä voi toteuttaa myös 

inkrementaalista datan latausta siten, että vain uudet ja päivittyneet 

tietueet päivittyvät Power BI:hin. Lisätietoja: 

https://docs.microsoft.com/en-us/power-bi/service-premium-

incremental-refresh (Inkrementaalisten latausten määritystä ei 

opiskella peruskurssilla.) 

Reaaliaikainen yhteys Power BI tietojoukkoon (dataset) 

Kun Power BI -tiedosto on julkaistu Power BI pilvipalveluun, siitä 

muodostuu pilvipalvelussa tietojoukko (dataset). Koska analyysipalvelu ja 

Power BI perustuvat samaan teknologiaan, myös Power BI Datasettiin voi 

ottaa reaaliaikaisen yhteyden kuten analyysipalvelun tietomalliin. 

Reaaliaikainen live connection -yhteys + muita tietolähteitä 

Power BI -tuotteen alkuajoista lähtien käyttäjät ovat kaivanneet 

mahdollisuutta yhdistää live connection -malli sekä omia tietolähteitä. 

Monesti on ollut tarpeen esimerkiksi rikastaa raporttia paikallisilla Excel-

aineistoilla.  

Joulukuuhun 2020 asti se ei ollut mahdollista ja edelleenkin kyseinen 

ominaisuus on vasta preview-vaiheessa. Se tarkoittaa, että ominaisuuteen 

saattaa tulla vielä muutoksia ja ominaisuus saattaa sisältää merkittäviä 

puutteita ennen kuin se päätyy viralliseksi Power BI -ominaisuudeksi.  

https://docs.microsoft.com/en-us/power-bi/service-premium-incremental-refresh
https://docs.microsoft.com/en-us/power-bi/service-premium-incremental-refresh
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Tällä hetkellä 01/2022 yhdistämismahdollisuus toimii vain Azure Analysis 

Services ja Power BI Dataset -mallien yhteydessä. Jos olet kiinnostunut 

mahdollisuudesta, lue tästä artikkelista lisää: Using DirectQuery for 

datasets and Azure Analysis Services (preview) - Power BI | Microsoft Docs 

Tekninen toteutus perustuu siihen, että live connection muutetaan ns. 

Direct Query -tyyppiseksi yhteydeksi luomalla ns. paikallinen malli, jonka 

jälkeen tiedostoon voi ladata muuta dataa. 

Opi lisää Power Queryä 

Power Query on erittäin monipuolinen ja se tarjoaa runsaasti erilaisia 

vaihtoehtoja.  

Voit opiskella kyselyeditoria perusteellisemmin verkossa olevasta  

• suomenkielisestä oppaasta: https://hexcelligent.fi/power-query-

opas/ tai 

• powerbi.com –sivustolla olevien englanninkielisten ohjeiden 

avulla: https://powerbi.microsoft.com/en-

us/documentation/powerbi-desktop-data-sources/ valitsemalla 

oikealta Connect to data tai Transform and shape data 

Netistä löytyy runsaasti hyviä ohjeita sekä YouTube-videoklippejä 

erilaisista Power Queryn toiminnoista, joten ohjeita kannattaa etsiä myös 

sopivilla hakusanoilla. 

Jos olet tekninen BI-asiantuntija ja/tai käytät tietolähteinä usein SQL-

kantoja tai muita tietokantoja, tutustu myös mitä tarkoittaa ns. query 

folding. 

  

https://docs.microsoft.com/en-us/power-bi/connect-data/desktop-directquery-datasets-azure-analysis-services
https://docs.microsoft.com/en-us/power-bi/connect-data/desktop-directquery-datasets-azure-analysis-services
https://hexcelligent.fi/power-query-opas/
https://hexcelligent.fi/power-query-opas/
https://powerbi.microsoft.com/en-us/documentation/powerbi-desktop-data-sources/
https://powerbi.microsoft.com/en-us/documentation/powerbi-desktop-data-sources/
https://exceleratorbi.com.au/how-query-folding-works/
https://exceleratorbi.com.au/how-query-folding-works/
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5 Tiedon mallinnus 

Kun olet ladannut kyselyiden tulokset PBI Desktopiin, datalle tehdään 

yleensä seuraavanlaisia mallinnusoperaatioita: 

© taulujen välisten yhteyksien tarkistaminen & luonti 

© kenttien eli sarakkeiden muotoilu (pvm-muoto, desimaalien määrä) 

© kenttien luokittelu (maantieteelliset kentät, url-osoitteet, numeeriset 

ei-laskennalliset tiedot), 

© lajittelujärjestysten määritys, jos tekstitietoja haluaan lajitella muuhun 

kuin aakkosjärjestykseen 

© teknisten sarakkeiden piilotus raporttinäkymästä, 

© oletuslaskutoimitusten määritys, 

© hierarkioiden laatiminen, 

© tiedon ryhmittely 
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Mallinnusta toteutetaan kahdessa eri näkymässä. Voit suorittaa 

mallintamiseen liittyviä toimenpiteitä  

• Data (Tiedot) -näkymässä Column tools (Saraketyökalut) -

välilehdeltä. 

 
 

• Model (Malli) -näkymässä Properties (Ominaisuudet) -paneelin avulla 

 

 Näkymien oleellisimmat erot 

 

Data-näkymässä voit valita vain yhden sarakkeen eli kentän kerralla.  

 

Model-näkymässä voit valita useita kenttiä Ctrl-näppäimen avulla 

jopa useista eri tauluista ja suorittaa niille mallinnustoimenpiteitä 

samanaikaisesti Properties-paneelin avulla. 
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5.1 Kenttien muotoilu 

Power Queryssä määritetään sarakkeiden tietotyyppi ja tehdään muita 

muokkauksia datalle.  

Muotoilut ja muut "metatiedot" määritetään vasta datan lautauksen 

jälkeen PBI Desktopin pääikkunassa.  

Alla olevassa kuvassa toimenpide suoritetaan Column tools 

(Saraketyökalut) -välilehdeltä, mutta sen voisi tehdä myös Model (Malli)-

näkymässä Properties (Ominaisuudet) -paneelissa.  

 

Tuhaterotin valitaan pilkku-painikkeella ja erotin määräytyy Windowsin 

kansallisuusasetusten perusteella. 

 

Column tools (saraketyökalut) -välilehdellä voi myös vaihtaa sarakkeen 

tietotyyppiä (data type), mutta tietotyypin valinta on hyvä tehdä jo Power 

Queryssä, jotta esimerkiksi yhdysvaltalaisessa muodossa olevat luvut 

pystyy määrittämään oikein.   
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5.2 Luokittelut 

Maantieteelliset kentät 

Maantieteelliset kentät luokitellaan, jotta karttavisualisoinnit toimivat. 

 

Maantieteellisten kenttien edessä näkyy kenttäluettelossa maapallon 

symboli. 

Huomaa, että Power BI:n eri karttavisualisoinnit käyttävät eri 

karttapalveluita, joten luokittelut eivät välttämättä toimi kaikissa kartoissa 

samalla tavalla.  

Kentän sisällön pitää olla riittävän yksikäsitteinen, jotta karttapalvelut 

osaava sijoittaa sijainnit kartalle oikein. Yhdistele tietoja tarvittaessa ja 

määritä tiedot Place (Paikka) -tyyppisiksi. 

 

 

Lue kartoista lisää: https://hexcelligent.fi/2018/01/10/kartat-power-bissa/  

https://hexcelligent.fi/2018/01/10/kartat-power-bissa/
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URL-osoitteet 

Mikäli aineistosi sisältää Web URL-linkkejä tai linkkejä kuviin (Image URL), 

määritä myös ne, jotta PBI ymmärtää kyseiset tiedot kuviksi tai linkeiksi, ei 

pelkästään merkkijonoiksi. 

 

 

Ks. Suomalaiset postimerkit – vilahdus.fi 

 

 

http://vilahdus.fi/suomalaiset-postimerkit/
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5.3 Lajittelujärjestykset 

Tiedot lajitellaan raporteissa aina joko numeeriseen tai 

aakkosjärjestykseen. Jos datassasi on tekstisarakkeita, joiden tiedot pitäisi 

lajitella muuhun kuin aakkosjärjestykseen, taulussa pitää olla numeerinen 

sarake, jonka perusteella lajittelu tehdään.  

Aakkosista poikkeava lajittelu määritellään sarakekohtaisesti Column tools 

(Saraketyökalut) –välilehdeltä löytyvän Sort by Column (Lajittele 

sarakkeen mukaan) –painikkeen avulla tai Model (Malli) -näkymän 

Properties (Ominaisuudet) -paneelista. 

 

Jos määrität sarakkeelle lajittelujärjestyksen, saraketta ei voi enää lajitella 

aakkosjärjestykseen.  

Tee tarvittaessa Power Queryssä sarakkeesta kaksoiskappale, jos jokin tieto 

pitää pystyä eri visualisoinneissa näyttämään joko aakkosjärjestyksessä tai 

tiettyyn numeroon perustuvassa järjestyksessä. 

5.4 Teknisten sarakkeiden piilotus 

Edellä mainitun kaltaisia teknisiä 

lajittelusarakkeita ei yleensä 

käytetä raporteissa, joten ne 

piilotetaan raportointinäkymästä. 

Usein myös ns. dimensionaalisten 

mallien ns. faktatauluissa olevat id-

kentät piilotetaan, jottei 

esimerkiksi tuoteid:t näy 

raportointipuolella eri tauluissa. 
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5.5 Oletuslaskutoimitukset 

Tauluissa on usein numeerisia sarakkeita (kuten vuosiluku tai rivinumero), 

joilla ei lasketa aritmeettisia laskutoimituksia. 

Ne kannattaa määrittää Don't summarize (Älä tee yhteenvetoa) -

tyyppisiksi, jottei Power BI yritä laskea lukuja yhteen. 

 

5.6 Muita mallinnustoimenpiteitä 

Edellä kuvattujen tavallisimpien mallinnustoimenpiteiden lisäksi 

tietomalleihin voidaan luoda ns. hierarkioita tai toteuttaa datan 

luokitteluita.  

Löydät lisätietoja esimerkiksi alla olevista artikkeleista: 

• What a Power BI Hierarchy Is, and How to Use it? - RADACAD 

• Use grouping and binning in Power BI Desktop - Power BI | Microsoft 

Docs 

  

https://radacad.com/what-a-power-bi-hierarchy-is-and-how-to-use-it
https://docs.microsoft.com/en-us/power-bi/create-reports/desktop-grouping-and-binning
https://docs.microsoft.com/en-us/power-bi/create-reports/desktop-grouping-and-binning
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5.7 Taulujen väliset yhteydet 

Tietomallin rakenne 

Kun ryhdyt toteuttamaan useista tauluista muodostuvia tietomalleja, sinun 

on hyvä ymmärtää relaatiomallinnuksen peruskäsitteitä. Peruskurssin 

materiaalissa kerrotaan ainoastaan, miten relaatiot teknisesti luodaan 

Power BI Desktopin käyttöliittymässä. Jatkokurssilla opiskellaan syvemmin 

mallinnukseen liittyvää teoriaa. 

 Huomaa, että kaikki Power BI:ssä perustuu oikeanlaiseen tietomalliin. 

Väärin tehty malli pitää mahdollisesti myöhemmin toteuttaa 

uudelleen. Kun ryhdyt toteuttamaan laajempaa raportointisovellusta, 

opiskele ensin mitä tarkoittaa dimensionaalinen tähtimalli, sillä se 

soveltuu parhaiten Power BI:n tietomalliksi. 

 

Huomaa myös, että jos olet tekemässä Power BI:llä vain hyvin 

yksinkertaista raportointia eikä sinun tarvitse yhdistellä dataa, kuten 

toteutumia, budjetteja ja ennusteita, saatat pärjätä pelkällä yhdellä 

isolla ns. flat-taululla. Flat-taulu ei kuitenkaan yleensä sovi laajemman 

raportointikokonaisuuden rungoksi.  

Lisätietoja:  

https://docs.microsoft.com/en-us/power-bi/guidance/star-schema 

Yhteyksiin liittyvät asetukset  

Kun lataat tietomalliin uusia tauluja, Power BI yrittää tulkita niiden välisiä 

relaatioita. Power BI:n tulkitsemat relaatiot eivät välttämättä ole oikein, 

joten tarkista aina muodostuneet relaatiot tai poista ennen datan latausta 

asetus, joka yrittää tulkita relaatioita puolestasi.  

Voit estää tulkinnanvaraiset eli mahdollisesti virheelliset tai ylimääräiset 

relaatiot asetuksella File > Options and settings > Options > Data Load 

> Autodetect new relationships after data is loaded (Tiedosto > 

Asetukset ja vaihtoehdot > Valinnat > Tietojen lataaminen > Havaitse 

uudet suhteet automaattisesti tietojen lataamisen jälkeen). Asetus on 

tiedostokohtainen. 

https://docs.microsoft.com/en-us/power-bi/guidance/star-schema
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Jos Power BI:n luo relaatiot tulkinnanvaraisesti, kuljeta hiiri relaatioiden 

päälle ja tarkista, että ne ovat muodostuneet oikein taulujen välille. Sinun 

pitää itse tuntea data ja tietää, miten taulut pitää oikeasti yhdistää 

toisiinsa, jotta malli toimii oikein. 
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Voit myös kaksoisnapsauttaa yhteysviivaa tai valita yhteysviivan päältä 

pikavalikosta Properties (Ominaisuudet) ja tarkistaa relaation tiedot 

avautuvasta ikkunasta. Jos relaatio on muodostunut väärien kenttien 

perusteella, voit poistaa relaation pikavalikon avulla. 

Luot relaatioita tarttumalla hiirellä kenttään ja vetämällä sen vastaavan 

kentän päälle toiseen tauluun. Relaatioita voi luoda myös valintanauhassa 

olevalla Manage Relationships (Suhteiden hallinta)-painikkeella. 

Power BI tukee yhden-suhde-moneen (one-to-many) sekä yhden-suhde-

yhteen (one-to-one) yhteyksiä, mutta antaa virheilmoituksen, jos yrität 

luoda monen-suhde-moneen (many-to-many) -yhteyttä eli yhdistävässä 

kentässä on molemmissa tauluissa samoja arvoja. Saat virheilmoituksen 

myös, jos perusavainkentässä on tyhjiä soluja. 

Esimerkiksi alla olevassa taulussa kukin ResellerID esiintyy vain kerran, eli 

ResellerID on yksilöllinen arvo, kuten luku 1 yhteyden päässä kertoo. 

Jokaiselle jälleenmyyjälle on myyty paljon eli jälleenmyyjän tunnus esiintyy 

myyntiaineistossa useita kertoa, mistä puolestaan kertoo Sales-taulun 

päässä oleva tähti. Vastaavasti product-taulussa kukin tuotetunnus on 

kertaalleen, mutta tuotenimike esiintyy monissa myyntiriveissä. 
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 Älä luo Power BI:ssä monen-suhde-moneen (many-to-many) -

yhteyksiä, sillä ne voivat aiheuttaa virheellisiä tuloksia!  

 

Monen-suhde-moneen yhteydet ratkaistaan luomalla taulujen välille 

ns. liitostauluja (join table, bridge table).  

 Monen-suhde-moneen (many-to-many) -relaatio on olemassa vain 

teknisistä syistä, kun tehdään yhdistelmämalleja (composite models), 

joihin osa datasta on tuotu (import) ja osa yhdistetty direct query -

tekniikalla. Älä käytä malleissa monen-suhde-moneen -relaatioita ellet 

tiedä, mitä olet tekemässä. 

 

Lisätietoja: Many-to-many relationships in Power BI Desktop - Power 

BI | Microsoft Docs 

 

Emme perehdy Power BI perusteet -kurssilla syvällisesti mallintamisen 

teoriaan, joten tutustu aihepiiriin, mikäli datassasi esiintyy many-to-

many -relaatioita. 

  

https://docs.microsoft.com/en-us/power-bi/transform-model/desktop-many-to-many-relationships
https://docs.microsoft.com/en-us/power-bi/transform-model/desktop-many-to-many-relationships
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Dimensionaalinen malli 

Alla olevassa mallissa Sales-taulu on ns. faktataulu, joka sisältää 

tapahtumia eli myyntirivejä eli laskettavaa tietoa. Muut taulut puolestaan 

kuvailevat myynteihin liittyviä objekteja (tuote, työntekijä, jälleenmyyjä 

jne.) ja niitä kutsutaan yleensä dimensiotauluiksi. 

 

Lue lisää tiedon mallinnuksesta esimerkiksi Excelerator BI-blogista 

http://exceleratorbi.com.au/knowledge-base/ Key Concepts –valikosta. 

Dimensionaalista mallinnusta opiskellaan perusteellisemmin 

syventävämmillä kursseilla. 

5.8 Kalenteri-taulu 

Yleensä Power BI -malleihin tuodaan ns. kalenteri-taulu, jota usein 

kutsutaan date-dimensioksi. Kalenteri-taulun voi luoda myös DAX-kielellä 

tai toteuttaa M-kielellä Power Queryssä. 

Löydät kalenteritauluista lisätietoja vaikkapa täältä: 

https://docs.microsoft.com/en-us/power-bi/desktop-date-tables  

Lue myös: Power BI – päivämäärätaulukko vai automaattinen 

päivämäärähierarkia? | HExcelligent.fi 

http://exceleratorbi.com.au/knowledge-base/
https://docs.microsoft.com/en-us/power-bi/desktop-date-tables
https://hexcelligent.fi/2020/10/11/power-bi-ja-paivamaarat/
https://hexcelligent.fi/2020/10/11/power-bi-ja-paivamaarat/
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6 Laskentalogiikka 

Perusoppaassa on vain lyhyt laskentakaavoihin liittyvä perusohje. 

6.1 Helppo ad-hoc ”laskeminen” 

Jos teet nopeita 

pikaraportteja, voit 

määrittää 

yhteenvetofunktioita 

helposti ”lennosta”, kuten 

tekisit Excelin pivot-

taulukoissa. Valitse kenttä 

visualisointiin ja valitse 

kentän valikoista 

haluamasi 

yhteenvetofunktio. 

 

 

 Tällaiset ”lennosta” valitut laskutoimitukset eivät ole fyysisesti 

olemassa eli niitä ei voi hyödyntää jatkolaskennassa. Niihin ei siis voi 

viitata muista kaavoista. Pikakaavoista ei siten ole juurikaan hyötyä, 

kun toteutetaan monipuolisempaa laskentalogiikkaa edellyttäviä 

raportteja. 
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6.2 Mittarit (measures) 

Yleensä yhteenvetotulokset lasketaan ns. mittareina (measures). Mittarit 

ovat DAX-kielisiä kaavoja. Mutta miksi käyttää mittareita, jos 

yhteenvetofunktioita voi valita helposti myös valikosta? 

Laskenta kannattaa tehdä kaavoina, jotta niitä voi käyttää muissa 

kaavoissa kuten erilaisissa vertailuissa, prosenttiosuuksissa tai vaikkapa 

kumulatiivisissa aikaälykkäissä laskelmissa. 

Mittareita voi luoda monella eri tavalla, kuten taulun päältä pikavalikosta. 

Valikossa on myös ns. pikamittari (quick measure), jonka avulla voi luoda 

parikymmentä erilaista avustettua kaavaa, kuten ryhmitellyn keskiarvon, 

vuoden alusta tähän päivään kaavan, jne. Valitettavasti pikamittareiden 

valikoima on hyvin suppea. 

  
Kun olet luonut mittareita, ne näkyvät taulukoissa ja voit muotilla niiden 

tuloksen Measure tools (Mittarityökalut) -välilehdeltä. Mittareita ei 

välttämättä tarvitse sijoittaa samaan tauluun laskettavan datan kanssa. 

Usein mittareita varten tehdäänkin erillinen ns. mittaritaulu Home > Enter 

data (Aloitus > Anna tiedot) -toiminnolla. 
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Muutamia esimerkkimittareita 

Sales-taulusta Quantity-sarakkeen summa:  

Total Quantity = SUM( Sales[Quantity] ) 

Product-taulun tuotevalikoiman koko: 

Product Portfolio Size = COUNTROWS( 'Product' ) 

Erilaisten myytyjen tuotenimikkeiden määrä: 

Sold Product Items = DISTINCTCOUNT( Sales[ProductID] ) 

Mittarit voivat viitata muihin mittareihin: 

Unsold Product Items = [Product Portfolio Size] – [Sold Product 

Items] 

Unsold Product Percentage = DIVIDE( [Unsold Product Items] , 

[Product Items Quantity] ) 

Miksi siis mittari? 

© Mittareihin voi viitata muista kaavoista. Pystyt huomattavasti 

helpommin toteuttamaan monipuolisempia kaavoja, kun olet ensin 

laatinut tarvittavat perusmittarit.  

© Mittarit voi aina muotoilla Measure tools (Mittarityökalut) -

välilehdeltä.  

© Kun olet käyttänyt Power BI -mallissasi mittareita ja julkaissut mallin 

pilvipalveluun, voit muodostaa mallista myös Excelissä pivot-

taulukoita. Pivot-taulukot edellyttävät, että laskenta on toteutettu 

mittareina. 

© Lähes kaikki edistyneempi liiketoimintalogiikka edellyttää mittareita, 

joten niitä on hyvä harjoitella alusta lähtien aloittaen yksinkertaisista 

perusmittareista.  

Mittarit erottaa muista kentistä laskin-symbolista. 
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6.3 Laskennalliset sarakkeet 

Jos aineistossasi ei ole valmiiksi tarvittavia sarakkeita, voit luoda myös niitä 

tietomalliin.  

Voit lisätä kaavasarakkeita joko taulun päältä pikavalikosta tai siirtymällä 

Data-näkymään ja valitsemalla Table tools > New Column 

(Taulukkotyökalut > Uusi sarake). 

Kuten mittarille, sarakkeelle annetaan nimi, yhtäsuuruusmerkki ja sen 

jälkeen kaava. Kun viittaa kaavassa sarakkeeseen, käytä taulun nimeä ja 

kentän nimeä hakasulkeissa 

Row Total = Sales[Quantity] * Sales[UnitPrice] 

Voit käyttää kaavoissa välilyöntejä esimerkiksi 

laskutoimitusoperaattoreiden ympärillä. Lisäksi tarjolla on kymmenittäin 

Excelin kaltaisia funktioita, kuten IF, MONTH, ROUND jne. 

 

Kun sarake on luotu, voit seuraavaksi tehdä mittarin, joka laskee kyseisestä 

sarakkeesta summan. 

Total Sales Amount = SUM( Sales[Row Total] ) 

Jos taulun nimessä on välilyöntejä, ääkkösiä tai muita erikoismerkkejä tai 

taulun nimi on ns. varattu sana, sen ympärillä käytetään heittomerkkejä, 

kuten  
Väestötiheys=’Suomen kunnat’[Väkilkm]/’Suomen kunnat’[Pinta-ala] 
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 Usein turhat kaavasarakkeet (kuten Row Total) piilotetaan 

raportointinäkymästä ja jätetään tauluihin näkyviin vain mittareita 

(kuten Total Sales Amount).  

Sarake vai mittari vai molemmat? 

Mittareiden avulla voidaan vähentää turhien laskettujen sarakkeiden 

käyttöä, jotka kasvattavat mallin fyysistä kokoa. Esimerkiksi edellisellä 

sivulla on luotu ensin Row Total -kaavasarake, josta on laskettu mittarin 

avulla vielä summa. Koska Power BI -mallit ovat muistinvaraisia eli ne ovat 

latautuneina muistiin, muistia pyritään yleensä säästämään.  

Kaksivaiheisesti toteutettu laskenta (ensin kaavasarake ja sitten summaava 

mittari) olisi voitu toteuttaa yhtenä mittarina ilman turhaa tietomallin 

kokoa kasvattavaa kaavasaraketta: 

Total Sales Amount =  

    SUMX(Sales, Sales[Quantity] * Sales[UnitPrice]) 

Yllä olevassa kaavassa ei voi käyttää tavallista SUM-funktiota, sillä se ei 

salli kertolaskun kaltaista lauseketta argumentiksi. SUM-funktiolle voi 

antaa argumentiksi vain sarakkeen. 

Mittarit ovat hyvin tärkeä osa tietomallin laatimista ja ne tarjoavat 

huomattavan monipuoliset mahdollisuudet, kuten kymmenittäin time 

intelligence -funktioita, kuten TOTALYTD, SAMEPERIODLASTYEAR, jne. 

Huomaa, että time intelligence -funktioiden käyttö edellyttää, että 

tietomalliin on luotu myös ns. kalenteritaulu (date table, date dimension). 

Tällä lyhyellä Power BI perusteet -kurssilla ei ole mahdollisuutta perehtyä 

syvällisesti DAX-kieleen, kalenteritauluun tai aikaälykkyyteen, joten sen 

opiskelua voi jatkaa omatoimisesti tai jatkaa syventävämmille kursseille 

kuten Power BI jatko -kurssilla tai DAX-kielen perusteet. 

DAX-kielestä löytyy myös runsaasti kirjallisuutta sekä hyviä nettiartikkeleita 

ja sivustoja, kuten 

- https://www.daxpatterns.com/ 

- https://www.sqlbi.com/articles/start-learning-dax-for-free/ 

https://www.daxpatterns.com/
https://www.sqlbi.com/articles/start-learning-dax-for-free/
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Hyvä kirja aloittelijalle: Supercharge Power BI: Power BI is Better When You 

Learn To Write DAX: Allington, Matt: 9781615470693: Amazon.com: Books  

Hyvä teos edistyneemmälle: https://www.amazon.com/Definitive-Guide-

DAX-intelligence-Microsoft/dp/1509306978/ref=pd_sbs_14_img_0/137-

7845434-6023637 

6.4 Milloin kaavat lasketaan uudelleen 

Mittarit laskevat tuloksia dynaamisesti eli sillä hetkellä, kun käyttäjä 

esimerkiksi valitsee vaihtoehtoja osittajista tai napsauttaa pylväskaavion 

pylvästä. Mittarin sisällä oleva TODAY() -funktio saa siis uuden arvon 

reaaliaikaisesti. 

Kaavasarakkeet lasketaan vain datan päivityksen jälkeen, minkä jälkeen 

niiden tulokset eivät enää muutu ennen seuraavaa päivitystä. Tämä on 

hyvä huomioida, jos kaavassa on käytetty esimeriksi TODAY() -funktiota, 

joka hakee kuluvan ajanhetken. Jos data on päivitetty viimeksi 

maanantaina, kaavassa käytetään edelleen maanantaita. 

6.5 Laskennallisten sarakkeiden ja mittareiden muotoilut 

Kun olet luonut joko sarakkeita tai mittareita, muotoile ne joko Column 

tools (Saraketyökalut) tai Measure tools (Mittarityökalut) -välilehdiltä, 

jottei sinun tarvitse muotoilla niitä jokaisessa visualisoinnissa erikseen. 

 

 

  

https://www.amazon.com/Supercharge-Power-BI-Better-Learn/dp/1615470697
https://www.amazon.com/Supercharge-Power-BI-Better-Learn/dp/1615470697
https://www.amazon.com/Definitive-Guide-DAX-intelligence-Microsoft/dp/1509306978/ref=pd_sbs_14_img_0/137-7845434-6023637
https://www.amazon.com/Definitive-Guide-DAX-intelligence-Microsoft/dp/1509306978/ref=pd_sbs_14_img_0/137-7845434-6023637
https://www.amazon.com/Definitive-Guide-DAX-intelligence-Microsoft/dp/1509306978/ref=pd_sbs_14_img_0/137-7845434-6023637
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Näyttöyksiköt (display units) 

Sarakkeiden ja mittareiden muotoilu ei vaikuta siihen, että eri visualisoinnit 

näyttävät lukuja oletusarvoisesti käyttämällä automaattista näyttöyksikköä 

(display unit), kuten 8,44M tai 5,63t. 

Käyttäjät näkevät mittayksiköt sen mukaisesti, minkä kielistä pilvipalvelua 

käyttävät. Esimerkkejä: 

Suomi Englanti Yksikkö 

23 t. 23K tuhatta 

23 milj. 23M miljoonaa 

23 mrd. 23bn miljardia  

(tuhatta miljoonaa) 

23 bilj. 23T biljoonaa 

 

Poista automatiikka sellaisista visualisoinneista, joissa haluat nähdä luvut 

sellaisenaan. Näyttöyksikköä ei pysty määrittämään keskitetysti, vaan se 

pitää vaihtaa erikseen jokaiseen visualisointiin. 
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7 Raporttien laatiminen 

7.1 Raporttisivut 

Raporttitiedostoon ja sivuihin liittyviä perusmäärityksiä löytyy View 

(Näytä) -välilehdeltä. 

 

Samassa tiedostossa voi olla eri kokoisia sivuja. Jos muutat sivun kokoa 

merkittävästi, valitse View > Page View (Näytä > Sivunäkymä) –

komennolla minkä kokoisena sivu näkyy oletusarvoisesti käyttäjille 

pilvipalvelussa.  

Jos esimerkiksi kasvatat paljon sivun korkeutta, todennäköisesti vaihtoehto 

Fit to Width (Sovita leveyteen) on paras vaihtoehto.  

Yksittäisen sivun muotoilut ja asetukset löytyvät 

napsauttamalla sivun tyhjää kohtaa ja siirtymällä 

Format your report page (Muotoile 

raporttisivua)-näkymään. 

 

 

 

 

 

 

  



 

Raporttien laatiminen 

 

   Sivu 59    

7.2 Visualisointien käsittely 

Seuraavassa on lyhyt ohje visualisointien käsittelystä. 

1. Vedä hiirellä kenttäluettelosta kenttä raporttisivulle tyhjään kohtaan 

tai rastita kenttä, jolloin sinulle muodostuu joko taulukko, pylväskaavio 

tai esimerkiksi kartta riippuen siitä minkä tyyppisen kentän valitsit 

visualisointiisi. Alla olevaan visualisointiin on muodostunut taulukko, 

sillä ensin on valittu tekstimuotoinen Category-otsikko ja vasta sitten 

luku. Jos luku olisi valittu ensin, olisi muodostunut pylväskaavio. 

Maantieteelliseksi luokiteltu kenttä muodostaisi kartan. 

 

 
 

Yllä olevassa kuvassa Total Sales Amount -kenttä näkyy paneelissa 

Values-alueella, sillä on kyseessä Table (Taulukko). Kentän nimen 

kohdalla näkyy valikko ja sen avulla voi valita halutun 

laskutoimituksen. Jos visualisointiin on valittu ns. mittari, 

laskutoimitusta ei voi valita valikosta. Luku näkyy oletusarvoisesti 

muotoiltuna siten, kuin se on muotoiltu joko Columns tools 

(Saraketyökalut) tai Measure tools (Mittarityökalut) -välilehdeltä. 

 

Voit myös aloittaa valitsemalla ensin visualisointilajin ja vetämällä 

kentät joko visualisointirunkoon arkille tai visualisointikuvakkeiden 

alapuolella oleviin ruutuihin. 
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2. Vaihda visualisoinnin laji Visualizations (Visualisoinnit) –paneelista.  

3. Sijoita aktiiviseen visualisointiin muut haluamasi kentät kuvassa A-

kirjaimella merkitylle alueelle. Huomaa, että erilaisia 

sisäänrakennettuja visualisointeja on jo yli 30 erilaista ja jokaisella on 

hieman erilaisia vaihtoehtoja tarjolla. Vaihtoehtoja on siis runsaasti ja 

kaupasta löytyy noin 300 mukautettua visualisointia. Eri kenttien 

merkitys selviää yleensä kokeilemalla. Tyypillisesti visualisoinnissa on 

ainakin yksi luokitteleva asia, kuten Akseli (Axis). Mahdollisesti toinen 

luokitusvaihtoehto, kuten Legend (Selite) ja yleensä vähintään yksi 

arvo (Value).  

 

  
 

4. Visualisoinnin muokkaamiseen tarkoitetut kolme eri välilehteä on 

merkitty kuvassa B-kirjaimella. Ensimmäisellä välilehdellä valitset 

visualisonnin sisällön, maalisiveltimen takaa teet erilaiset 

ulkoasumuotoilut ja kolmannelta välilehdeltä saatat löytää 

analytiikkaominaisuuksia. Esimerkiksi aikasarjaan perustuvaan 

viivakaavioon voi yleensä valita analytiikkaominaisuuksista ennusteen 

(forecast). 
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Kun lisäät raporttisivulle erilaisia visualisointeja, ne ovat automaattisesti 

keskenään vuorovaikutteisia.  

 Löydät visualisointien käsittelyyn liittyviä tarkempia ohjeita kurssilla 

jaetusta kalvosarjasta. 
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Mukautetut visualisoinnit 

Power BI Desktopissa on yli 30 sisäänrakennettua visualisointia. Niiden 

lisäksi voit ladata ns. mukautettuja visualisointeja komennolla Insert > 

More visuals > From AppSource (Lisää > Lisää visualisointeja > 

AppSourcesta).  

 

Visualisointeja voi ladata myös joko From 

my files (Tiedostoistani) –komennolla tai 

visualisointipaneelin kolmen pisteen 

painikkeella, jos olet ladannut etukäteen 

visualisointitiedoston itsellesi. 

Epävirallisempia visualisointeja löytyy myös 

mm. githubista. 

 

Microsoftin sertifioimien visualisointien kohdalla näkyy sininen 

tähtisymboli. 

Visualisoinnit näkyvät kyseisessä Power BI –tiedostossa 

visualisointipaneelissa sisäänrakennettujen visualisointien alapuolella.  

 

 

  

https://github.com/
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7.3 Raporttisivujen viimeistely 

Visualisointien, sivujen ja koko raportin suodattaminen 

Jos raportteja jaetaan hallitusti käyttöoikeuksiin perustuen joko 

organisaation sisällä tai organisaation ulkopuolelle, käyttäjä näkee oikealla 

suodatuspaneelin.  

Julkisesti nettiin jaetuissa raporteissa ei näy suodatuspaneelia, vaan 

suodatukset pitää toteuttaa osittajina (slicers). 

Suodatuspaneelin eri alueille voi 

kuljettaa kenttiä ja niiden 

perusteella voi tehdä erilaisia 

suodatuksia. 
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Kun raporttisivu on muuten valmis, 

viimeistele raporttisi kuljettamalla erilaisia 

filtterikenttiä Filters (Suodattimet) –paneeliin, 

jotta käyttäjät voivat suodattaa raportteja 

muillakin tavoilla kuin raporttiin valitsemiesi 

visualisointien avulla. 

 

Lisäsuodattimet voivat olla visualisointi- tai 

sivukohtaisia tai ne voivat vaikuttaa koko 

raporttiin. Voit tehdä filttereiden avulla myös 

erilaisia esivalintoja, jotka ovat voimassa, kun 

muut tarkastelevat raporttejasi.  

 

Visualisointikohtaisten suodattimien (visual level filters) avulla voi 

suodattaa valittuna olevaa aktiivista visualisointia. 

Sivutason suodattimien (page level filters) avulla käyttäjä voi suodattaa 

aktiivista sivua. 

Raporttitason suodattimien (report level filters) avulla käyttäjät voivat 

suodattaa koko raporttia. Huomaa, että tällaiseen globaaliin suodatukseen 

ei ole vielä Power BI:ssä muuta vaihtoehtoa tarjolla. Vaikka PBI Desktopissa 

suodatuspaneeli näyttää hieman sekavalta, Power BI -palvelussa selaimella 

paneeli on selkeä ja sisältää vain suodattimet. 

Porautumissuodattimen (drillthrough filters) avulla on mahdollista 

toteuttaa ns. porautumissivuja (drillthrough), joita löydät lisätietoja täältä. 

Porautumissuodattimet löytyvät edelleen visualisointipaneelin alaosasta. 

 

https://docs.microsoft.com/en-us/power-bi/desktop-drillthrough
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Kun määrität suodattimia, 

huomaa että kentän tyypistä ja 

visualisoinnista riippuen tarjolla 

on erilaisia suodatusmenetelmiä 

(filter type). 

 

Jos valitset suodatusalueelle päivämäärä-tyyppisen kentän, listalla on 

tarjolla myös suhteellinen suodatus (relative filter). Pystyt esimerkiksi 

määrittämään suodatuksen, joka näyttää dynaamisesti kuluvan vuoden tai 

kuukauden tiedot ilman että sinun pitäisi käydä muuttamassa 

suodatusehtoa vuoden vaihtuessa. 

Jos teet itse esisuodatuksia, voi 

piilottaa ne siten, että käyttäjät 

eivät näe niitä pilvipalvelussa. 

  

Voit myös lukita suodattimen 

sellaiseksi, ettei käyttäjä voi 

vaihtaa sitä, vaikka se olisi 

näkyvillä.  

 

 

 Lue miten pilvipalvelu tallentaa muistiin käyttäjien suodatuksia. Lue 

aiheesta täältä. 

 

  

https://powerbi.microsoft.com/en-us/blog/announcing-persistent-filters-in-the-service/
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Visualisointien välinen vuorovaikutteisuus 

Kun käyttäjä napsauttelee esimerkiksi visualisointien palkkeja ja sektoreita, 

muut visualisoinnit reagoivat siihen automaattisesti. 

Oletuksena 

reagointitapa on ns. 

korostuva eli highlight-

tyyppinen, mikä 

tarkoittaa, että muissa 

visualisoinneissa 

korostetaan millaisen 

osuuden valittu asia 

muodostaa 

kokonaisuudesta 

 

Toinen vaihtoehto on 

se, että visualisoinnin 

osien napsauttaminen 

suodattaa muita 

visualisointeja eli niissä 

näytetään ainoastaan 

valittuun asiaan 

liittyvää tietoa.  

 

Jos haluat, voit vaihtaa tiedostokohtaisesti oletuskäyttäytymisen 

jälkimmäiseksi eli suodattuvaksi, mutta silti halutessasi säätää 

visualisointikohtaisesti tietyt visualisoinnit korostuviksi.  

Valinta tehdään asetuksista komennolla File > Options and Settings > 

Options > Report Settings > Change default visual interaction from 

cross highlightning to cross filtering (Tiedosto > Asetukset ja 

vaihtoehdot > Valinnat > Raporttiasetukset > Muuta oletusarvon mukaista 

visualisoinnin vuorovaikutus ristiinkorostuksesta ristiinsuodatukseksi). 

Huomaa, että asetus vaikuttaa vain aktiiviseen tiedostoon. 
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Visualisointikohtainen vuorovaikutteisuuden säätäminen 

Valitsetpa minkä tahansa oletusasetuksen, voit aina säätä visualisointien 

välistä vuorovaikutusta erikseen. Valitse yksi visualisointi ja siirry Format 

(Muotoile) –välilehden kautta Edit Interactions (Muokkaa 

vuorovaikutuksia) –tilaan. Määritä tämän jälkeen muiden visualisointien 

oikeaan yläkulmaan esiin tulleiden painikkeiden avulla, miten ne 

käyttäytyvät. Voit helposti kokeilla miten eri vaihtoehdot vaikuttavat. 

 

Idea on se, että valitset vuorollaan kunkin visualisoinnin ja määrität miten 

se vaikuttaa muihin. 

Kun olet valinnut yhden visualisoinnin, mutta näkyy seuraavat symbolit tai 

ainakin osa niistä. Jos symbolien merkitys tuntuu epäselvältä, kokeile 

aktiivisena olevan visualisoinnin napsauttelua ja testaa miten 

vuorovaikutteisuus muuttuu, kun napsautat alla olevia painikkeita. 

 Ensimmäinen valittuna: visualisointi suodattuu (filter) 

täysin. Visualisoinnissa ei näytetä himmeällä 

kokonaistuloksia. 

 Toinen valittuna: visualisoinnissa korostetaan (highlight) 

valittu osuus. Visualisoinnissa näytetään myös 

kokonaistulos himmeämmällä värillä. 

 Kolmas vaihtoehto valittuna: Visualisoinnille ei tapahdu 

mitään, kun aktiivisena olevaa visualisointia napsautellaan. 

Kun olet tehnyt määritykset, poistu muokkaustilasta Edit Interactions 

(Muokkaa vuorovaikutuksia) -painikkeella.   
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Hierarkiat visualisoinnissa 

Jos sijoitat visualisoinnin ensimmäiseen kenttää useita hierarkiatasoja, 

käyttäjät voivat porautua alemmille tasoille joko pikavalikon tai 

visualisoinnin yläpuolelle ilmestyvien porautumispainikkeiden avulla. 

 

Ensimmäisellä ylös osoittavalla nuolipainikkeella noustaan ylös, jos on sitä 

ennen porauduttu alas (drill down). 

Toinen painike muuttuu painettaessa mustaksi, jonka jälkeen visualisoinnin 

palkkien napsautus porautuu alas (drill down). Kun toista painiketta painaa 

uudelleen se muuttuu vaaleaksi ja visualisointi käyttäytyy kuten aiemmin.  

Kuhunkin visualisointiin voi itse laatia millaisen hierarkian tahansa. 

Tietomalliin voi myös luoda ns. valmiita hierarkioita, jotta visualisointeja on 

helpompi laatia: What a Power BI Hierarchy Is, and How to Use it? - 

RADACAD 

 

https://radacad.com/what-a-power-bi-hierarchy-is-and-how-to-use-it
https://radacad.com/what-a-power-bi-hierarchy-is-and-how-to-use-it
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Kolmas painike 

porautuu alemmalle 

tasolle siten, että 

ylemmän tason 

tietoja (kuten 

maakunta) ei enää 

näytetä. 

 

 

 

Viimeinen painike 

porautuu alas siten, 

että ylemmän tason 

tiedot näkyvät 

edelleen (kuten 

maakunta). 

 

 

 

Jos teet matriisin (matrix), siinä 

näkyy automaattisesti 

hierarkkiset + ja – painikkeet.  
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Mobiiliraporttien määritys 

Jos aiot julkaista raportin Power BI –pilvipalveluun ja käyttäjät katsovat 

raportteja mobiililaitteilla, voit määrittää mobiilinäkymän View>Phone 

Layout (Näytä > Puhelinasettelu) -näkymässä. Palaat takaisin 

normaalinäkymään samalla painikkeella. 

 

Kun käyttäjä pitää puhelinta vaakatasossa, hän näkee tavallisen näkymän. 

Kun hän kääntää puhelimen pystyasentoon, näkymä vaihtuu sellaiseksi 

kuin olet määrittänyt puhelinasettelunäkymässä. 

 Helmikuusta 2022 lähtien visualisointeja on voinut muokata erilaisiksi 

mobiilinäkymissä verrattuna siihen, miten ne näkyvät 

normaalinäkymässä. 

Lue lisää: https://powerbi.microsoft.com/en-us/blog/create-stunning-

mobile-reports-with-the-updated-mobile-authoring-in-power-bi-

desktop/ 

  

https://powerbi.microsoft.com/en-us/blog/create-stunning-mobile-reports-with-the-updated-mobile-authoring-in-power-bi-desktop/
https://powerbi.microsoft.com/en-us/blog/create-stunning-mobile-reports-with-the-updated-mobile-authoring-in-power-bi-desktop/
https://powerbi.microsoft.com/en-us/blog/create-stunning-mobile-reports-with-the-updated-mobile-authoring-in-power-bi-desktop/
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Raporttisivujen skaalautuminen 

Sivun skaalautuminen kannattaa tarkistaa erityisesti, jos olet muuttanut 

raporttisivujen kokoa. Kokeile kullakin sivulla mikä on raporttisivun paras 

esitysmuoto. 

 

Fit to Page (Sovita sivulle) skaalaa sivun sekä pysty- että vaakasuuntaisesti 

mahtumaan näytölle. 

Fit to Width (Sovita leveyteen) säätää raportin mahtumaan 

leveyssuunnassa. Tämä sopii esimerkiksi raporteille, jotka ovat hyvin 

korkeita ja pienenevät liian pieniksi, mikäli ne skaalataan mahtumaan 

näytölle. 

Actual Size (Todellinen koko) näyttää raportin alkuperäisessä koossaan 

skaalaamatta sitä. 
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Rivitason käyttöoikeuksien määritys 

Power BI perusteet -kurssilla ei opiskella rivitason käyttöoikeuksia 

tarkemmin, mutta niiden määritys on yksi PBI Desktopissa tehtävistä 

määrityksistä.  

Rivitason käyttöoikeus tarkoittaa sitä, että eri henkilöt näkevät eri dataa. 

Jotkut esimerkiksi näkevät vain Euroopan myyntialueen tietoja ja toiset 

Yhdysvaltojen. 

Rivitason käyttöoikeudet (Row Level Security) toteutetaan luomalla PBI 

Desktopissa ns. rooleja ja määrittämällä rooleihin perustuvia sääntöjä 

DAX-kielellä. Kun roolit on määritetty, käyttäjät kytketään rooleihin 

pilvipalvelun puolella. 
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8 PBIX-tiedoston julkaiseminen pilvipalveluun 

Kun tiedosto on luotu PBI Desktopissa, sen voi julkaista pilvipalveluun. 

Oma työtila (my workspace) on tarkoitettu henkilökohtaisille raporteille tai 

testailuun. Yleensä raportit julkaistaan yhteisiin raportointityötiloihin. 

Ilmaislisenssillä voi julkaista vain henkilökohtaiseen työtilaan. Pro-

lisenssillä tai Premium per User -lisensseillä voi julkaista yhteisiin 

raportointityötiloihin. 
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9 Power BI -pilvipalvelun ominaisuuksia 

Seuraavassa on listattu Power BI palvelun ominaisuuksia, joista vain 

oleellisimpiin tutustutaan tällä peruskurssilla: 

• Työtilojen käyttö (workspace), 

• Sisällön jakaminen, 

• Koontinäyttöjen (dashboard) luonti sekä niiden jakaminen muille, 

• Raporttien jakaminen tai upottaminen julkisesti webiin, 

• Raporttien upottaminen SharePoint Onlineen, 

• Raporttien näyttäminen Teamsissa välilehtinä, 

• Luonnollisen kielen kaltaiset kyselyt englanniksi koontinäytöillä 

kuten ”Sales by salesperson in 2021”, 

• Hälytysten tilaaminen sähköpostiin, 

• Hälytysten tilaaminen yksittäisistä korteista, 

• Datan päivityksen ajastus, 

• Mahdollisuus toteuttaa julkaistuista tietomalleista PBI -raportteja 

selaimella ilman Power BI Desktopia, 

• Mahdollisuus ottaa Power BI Desktopista ns. live connection -

yhteys julkaistuun malliin ja luoda uusia Power BI -

visualisointitiedostoja sen pohjalta, 

• Mahdollisuus toteuttaa julkaistuista tietomalleista Excelissä Pivot-

taulukoita, 

• Raporttien mobiilikäyttö, 

• Käyttäjien kytkeminen käyttöoikeusrooleihin. 
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10 Power BI –pilvipalvelun käytön aloittaminen 

Julkisella Power BI perusteet -kurssilla ei opiskella perusteellisesti 

pilvipalvelun toimintoja, sillä kaikki kurssilaiset eivät välttämättä käytä 

pilvipalvelua vaan jakavat raportteja Power BI Report Server -ympäristössä. 

Luo ensin tunnus Power BI –palveluun. Tarvitset yrityssähköpostiosoitteen, 

sillä esim. @live.com tai @gmail.com –tunnukset eivät kelpaa. Huomaa, 

että sinulla voi jo olla tunnus, jos organisaatiosi O365 pääkäyttäjä on 

kytkenyt sinulle lisenssin. Huomaa myös, että pääkäyttäjä on voinut estää, 

ettet voi luoda sähköpostiosoitteellasi Power BI –tunnusta. 

1. Siirry osoitteeseen powerbi.com 

2. Valitse ikkunan oikeasta yläkulmasta sign up free ja syötä 

pyydetyt tiedot.  

 

Jos sinulla on jo tunnus, käytä Sign in –vaihtoehtoa kirjauaksesi 

palveluun tai kirjaudu palveluun esimerkiksi office.com –sivuston 

kautta. 

 Jos sinulla on jo O365:n kautta Power BI -pilvipalvelutunnus, se saattaa 

olla ilmaistunnus (Free), jolla ei voi itse jakaa eikä käyttää muiden 

jakamia raportteja. Pro- ja Premium per User -lisenssit sallivat 

raporttien jakamisen muille. 

10.1 Tietoja Power BI -lisensseistä 

Voit tarkistaa millainen lisenssi käytössäsi on kirjautumalla Power BI -

pilvipalveluun (esimerkiksi powerbi.com -osoitteesta) ja napsauttamalla 

oikeassa yläkulmassa näkyvää Options (Asetukset) -kuvaketta. Valitse 

Manage personal storage (Henkilökohtaisen tallennustilan hallinta).  

 

https://powerbi.microsoft.com/en-us/
https://www.office.com/
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Käyttäjäperusteiset Pro ja Premium per User -lisenssit 

Jos organisaatiossasi käytetään Pro-lisenssejä (noin 8 € per kk per 

käyttäjä), jokaisella sellaisella käyttäjällä pitää olla Pro-lisenssi, joka joko 

jakaa tai käyttää muiden jakamia raportteja. Jos sinulla on kalliimpi 

Premius per User -lisenssi, myös kaikilla käyttäjille pitää olla sama lisenssi, 

jotta voit jakaa heille raportteja. 

Free-lisenssiä voi käyttää vain henkilökohtaisessa käytössä tai sillä voi 

jakaa raportteja julkisesti nettiin. Pro ja Premium per User -lisensseihin 

perustuvissa malleissa Free-käyttäjät eivät voi käyttää muiden jakamia 

raportteja. 

Premium-lisenssi 

Jos työskentelet isossa organisaatiossa ja teillä on Premium -yrityslisenssi, 

Free-käyttäjät voivat käyttää heille jaettuja raportteja, mutta he eivät voi 

itse jakaa raportteja muille. Premium-lisenssimallissa maksetaan 

kuukausittaista organisaatiokohtaista lisenssimaksua (alkaen noin 4000 € 

per kk). Sen lisäksi raporttien kehittäjille on pitänyt hankkia 

henkilökohtaiset Pro-lisenssit (noin 8 € per kk per kehittäjä). 

Embedded-lisenssi 

Organisaatio on voinut hankkia myös ns. embedded-lisenssin, jolloin 

käyttäjät eivät käytä Power BI -pilvipalvelun käyttöliittymää lainkaan, vaan 

raportit on upotettu esimerkiksi itse toteutettuihin raportointisivustoihin. 

Embedded-lisenssimalleja on kaksi erilaista ja niiden lähtöhinta on noin 

600 € per kk, mutta ne vaativat yleensä sovelluskehitystä.  

 Pro- ja Premium-lisensseillä voi myös upottaa sisältöä erilaisille 

verkkosivustoille ja O365-sovelluksiin, mutta Embedded-lisenssi 

saattaa tulla edullisemmaksi käyttäjämäärän mukaan. 
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10.2 Power BI -pilvipalvelun työskentely-ympäristö 

Kun sinulla on Power BI -tunnus ja olet kirjautuneena Power BI –palveluun, 

Home (Aloitus) -näkymän pitäisi näyttää alla olevalta, ellei palveluun ole 

tullut muutoksia: 

 

 

 Huomaa navigaatiopalkissa oleva Learn (Hanki tietoja) -komento, jolla 

löydät runsaasti pilvipalvelun käyttöön liittyviä ohjeita. 

Power BI –palvelun kieli 

Voit vaihtaa pilvipalvelun kielen halutessasi.  

 

Kieli vaikuttaa mm. siihen, minkä kansallisuuden mukaan esimerkiksi 

raporttien luvut ja päivämäärät näytetään.  
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Suomenkielisessä pilvipalvelussa luvuissa näytetään desimaalierottimena 

pilkku ja tuhaterottimena välilyönti (englanninkielisessä pilvipalvelussa 

vastaavasti desimaalierottimena piste ja tuhaterottimena pilkku). Erottimiin 

vaikuttaa myös selaimen kansallisuusasetukset. 

Power BI -tiedosto työtilassa 

Vaikka Power BI Desktopissa tiedosto näkyy kehittäjälle yhtenä tiedostona, 

työtilaan julkaisun jälkeen siitä on muodostunut pilvipalveluun kaksi eri 

objektia: raportti (report) sekä tietojoukko (dataset). Tietojoukko sisältää 

tekniikan (kyselyt, mallinnuksen, laskentalogiikan) ja raportti ainoastaan 

raporttisivut. 

 

Yhdestä tietojoukosta voidaan luoda ja julkaista useita eri raportteja 

vaikkapa eri kohderyhmille, sillä tietojoukkoon voi kytkeytyä Power BI 

Desktopista komennolla Home > Power BI Datasets (Aloitus > Power BI -

tietojoukot): 
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Tietojoukosta (dataset) voi luoda myös Excel-raportteja, sillä 

tietojoukkoihin voi kytkeytyä myös Excelistä. Excelillä luotuja raportteja voi 

julkaista Power BI työtilaan Power BI -raporttien joukkoon ja jakaa Power 

BI -raporttien tavoin muille käyttäjille. 
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Power BI –pilvipalvelun käyttöliittymä ja ympäristö 

Kun tietomalli (data model) eli tietojoukko (dataset) eli Power BI Desktop –

.pbix -tiedosto on laadittu, tallennettu ja se on julkaistu Power BI -

palveluun, tietojoukoille (dataset) voi mm. määrittää automaattiset 

päivitykset ja raporteista (report) voi muodostaa koontinäyttöjä 

(dashboards). Yhdelle koontinäytölle voi kiinnittää näytettäväksi 

visualisointeja useista samassa työtilassa olevista raporteista. Koontinäyttö 

voi siis olla ns. saapumissivu, jonka kautta käyttäjät navigoivat varsinaisille 

raporteille. 

Myös Power BI pilvipalvelussa selaimella voi ladata data-aineistoja ja 

toteuttaa raportteja, mutta ominaisuudet ovat huomattavasti 

rajoitetummat Power BI Desktopiin verrattuna. Esimerkiksi tuotujen 

taulujen välille ei pysty luomaan yhteyksiä eikä malliin voi lisätä laskentaa 

eli tiedon mallinnustyökalut ja DAX-kieli puuttuvat. Käytännössä Power 

BI -mallit ja raportit toteutetaan yleensä aina Desktopissa ja 

julkaistaan tai tuodaan esimerkiksi New (Uusi) -komennolla Power BI 

palveluun. 

10.3 Työtilat (workspaces) 

Oma työtila (my workspace) 

Jokaisella käyttäjällä on oma henkilökohtainen työtila (workspace), johon 

voi tallentaa omia henkilökohtaisia raportteja ja josta niitä voi myös jakaa 

muille.  

Henkilökohtaiseen työtilaan ei yleensä suositella tallennettavan jaettavia 

raportteja, sillä työtilan omistajuutta ei voi siirtää toiselle henkilölle 

esimerkiksi työtehtävien vaihtumisen yhteydessä.  

 Omaa työtilaa voi käyttää henkilökohtaisten raporttien tallentamisen 

lisäksi Power BI pilvipalvelutyötilojen käytön harjoitteluun, sillä muut 

eivät näe raportteja ellet erikseen jaa niitä. 
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Yhteiset raportointityötilat 

Eri organisaatioissa Power BI:tä käytetään eri tavoin, mutta yleensä 

raportointia varten luodaan raportointityötiloja esimerkiksi kutakin 

toimintoa tai aihekokonaisuutta varten (esim. talouden tai myynnin 

raportointityötila). Tyypillisesti näissä työtiloissa on jäseninä vain 

raportointia toteuttavat henkilöt ja he jakavat raportteja käyttäjille yhdessä 

sovittujen käytäntöjen mukaisesti joko yksittäin tai paketoimalla sisältöä 

sovelluksiksi.  

Selvitä oman organisaatiosi jakelukäytännöt. 

Työtilan näkymä 

Kun olet joko omassa työtilassa tai yhteisessä työtilassa, jossa on sisältöä, 

näkymä on alla olevan kaltainen. 

  

Työtilan sisältövaihtoehdot 

Työtilassa on kolme näkymää  

• All (kaikki),  

• Content (Sisältö) eli raportit sekä koontinäytöt ja  

• Datasets + dataflows (Tietojoukot + tietovuo-taulut).  
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Power BI Desktop -tiedosto jakautuu pilvipalveluun julkaisemisen 

yhteydessä kahteen eri osaan, jotka tunnistaa erilaisista kuvakkeista: 

 
Tietojoukko eli dataset on .pbix -tiedoston "tekninen osa" eli 

sisältää kaikki kyselyt sekä tietomallin kaavoineen. 

 
Raportti (report) on .pbix -tiedoston raportointiosuus eli 

sisältää raporttisivut ja niissä olevat visualisoinnit. 

 

 
Lisäksi listalla voi koontinäyttöjä (dashboard), joihin on koottu 

eli linkitetty visualisointeja muista samassa työtilassa olevista 

raporteista.  

 
Jos Power BI -työtilaan on julkaistu myös Excel-raportteja, ne 

näkyvät omina kuvakkeinaan. 

 

Premium-työtiloissa voi olla myös ns. sivutettuja (paginated) Power BI Report 

Builder -raportteja. 

Peruskurssilla ei opiskella dataflows (tietovuo) -tekniikkaa. Niitä käytetään 

esimerkiksi keskitettyjen raportointiratkaisuiden toteutukseen, jottei 

kyselylogiikka tallennu erillisiin Power BI Desktop -tiedostoihin eli datasetteihin. 
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10.4 Katsaus: sisällön jakamisvaihtoehdot sekä tarkastelu 

Selvitä oman organisaatiosi jakamiskäytännöt. Sisällön jakaminen voi 

tapahtua seuraavilla tavoilla ja niistä kerrotaan tarkemmin myöhemmin 

kurssimateriaalissa. 

1. Työtilan sisältö voidaan julkaista eli paketoida ns. Appsiksi eli 

sovellukseksi, jolloin se näkyy käyttäjillä vasemmalla 

navigaatiossa Apps (Sovellukset) -luettelossa automaattisesti tai 

käyttäjät voivat hakea sovelluksen halutessaan sovellusluettelossa 

olevalla Get Apps (Hanki sovelluksia) -painikkeella.  

 

Appseina jakamista suositellaan erityisesti, kun sisältöä jaetaan 

hallitusti isoille käyttäjämäärille. Apps-jakamisessa on se etu, että 

kehittäjät voivat rauhassa kehittää sisältöä ja julkaista sitä 

hallitummin sisällön valmistuessa. Lisätietoja: 

https://docs.microsoft.com/en-us/power-bi/consumer/end-user-

apps 

 

Omaa työtilaa (my workspace) ei voi jakaa muille sovelluksena.  

Jos teillä on käytössä ns. Premium-lisenssi, työtilan nimen vieressä 

pitää näkyä "timantti" -symboli, jotta jakaminen muille on 

mahdollista. 

2. Sisältöä voi jakaa yksittäisinä raportteina tai raporteista 

pilvipalvelussa muodostettuina koontinäyttöinä, jolloin ne näkyvät 

käyttäjillä Shared with me (Jaettu kanssani) -listalla. Tätä tapaa 

käytetään, kun halutaan jakaa mahdollisimman helposti ilman 

byrokratiaa pienelle joukolle käyttäjiä, kuten omalle tiimille. 

 

Raportteja ja koontinäyttöjä voi jakaa muille myös omasta 

työtilasta, jos sinulla on Pro-lisenssi. Yleensä raportteja 

suositellaan jaettavaksi yhteisistä työtiloista. 

3. Käyttäjille on annettu oikeudet nähdä raportointityötila eli heille 

on annettu Viewer eli lukuoikeudet suoraan työtilaan. Tätä tapaa 

ei yleensä suositella, sillä käyttäjät näkevät tällöin työtilassa myös 

https://docs.microsoft.com/en-us/power-bi/consumer/end-user-apps
https://docs.microsoft.com/en-us/power-bi/consumer/end-user-apps
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mahdollisesti keskeneräistä sisältöä. Silti jotkut organisaatiot ovat 

päättäneet jakaa sisällön tällä tavalla lukija-oikeuksiin perustuen. 

 

 Huomaa, että jakaminen ja upottaminen ovat kaksi eri asiaa. Kun 

sisältöön on annettu käyttöoikeudet jollakin edellä kuvatuista tavoista, 

sisältöä voi halutessaan upottaa muualla käytettäväksi, kuten O365-

tuotteisiin, intraan tai jollekin muulle raportointisivustolle. Jotta 

upotettu sisältö näkyy käyttäjille, se on pitänyt ensin jakaa. 

 Sisältöä voi jakaa myös julkisesti Publish to web (Julkaiset verkkoon) -

komennolla, mutta kyseistä komentoa ei saa koskaan käyttää 

sisäisessä jakamisessa, sillä katseluikkunassa on toiminnot, joilla kuka 

tahansa voi jakaa sisällön kenelle tahansa esimerkiksi Facebookiin tai 

Twitteriin. Julkiset raportit indeksoituvat myös näkyviin esimerkiksi 

Google-hakuihin. 

 

Publish to web (Julkaise verkkoon) -toiminto on nykyisin 

oletusarvoisesti pois käytöstä Power BI -työtiloissa ellei teidän 

organisaationne Power BI Admin ole erikseen sallinut sen käyttöä. 

Yleensä julkaisuoikeus verkkoon annetaan vain tietyille käyttäjille, ettei 

kukaan vahingossa julkaise organisaation sisäisiä raportteja verkkoon. 

Selvitä oman organisaatiosi käytännöt. 
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Sinulle jaetut sisällöt 

 

Loppukäyttäjä tarkastelee sisältöä yleensä 

Home (Aloitus), Apps (Sovellukset) tai 

Shared with me (Jaettu minulle) -

näkymissä.  

Poikkeustapauksissa loppukäyttäjille on 

annettu oikeus käyttää raportteja samoissa 

työtiloissa, joissa kehittäjät toteuttavat 

raportointia.  

Tällöin he navigoivat kyseisiin työtiloihin 

Workspaces (Työtilat) -valikon kautta. 

 

Jos organisaatiossanne Power BI –sisällöt on jaettu yksittäisinä raportteina 

tai koontinäyttöinä (Dashboards) eli Share (Jaa) –toiminnolla, jaetut 

sisällöt saa esiin Shared with me (Jaettu kanssani) -linkillä. 

Jos sisältö tai osa sisällöstä on paketoitu sovelluksiksi, käyttäjät 

tarkastelevat raportteja Apps (Sovellukset) -näkymästä. Applikaatiot on 

joko asennettu automaattisesti heille tai he käyttävät näkymään 

siirryttyään Get Apps (Hanki sovelluksia) -toimintoa ja valitsevat itse mitä 

applikaatioita haluavat nähdä. 

Erilainen sisältö näkyy myös Home (Aloitus) -näkymässä. 
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Sisällön tarkastelu 

Kun tarkastelet sinulle jaettua sisältöä, johon sinulla ei ole itselläsi 

muokkausoikeuksia, näet yläpalkissa erilaisia toimintoja. Toiminnot 

vaihtelevat siitä riippuen tarkasteletko koontinäyttöä (dashboard) vai 

raporttia. Alla oleva kuva on sellaisesta raportista, joka on julkaistu osana 

Apps-sovelluspakettia. Koontinäytön (dashboard) valikossa on vähemmän 

toimintoja. 

 

Raportissa on tarjolla mm. seuraavanlaisia toimintoja: 

© File (Tiedosto), jolla voit tulostaa tai muodostaa vaikkapa 

upotuskoodin SharePoint-sivulle upottamista varten, 

© Export (Vie), jolla voit muodostaa Excel-raportin, PowerPoint-

esityksen, PDF:n tai tulostaa sisältöä. 

© Embed (Upota), jolla voit muodostaa koodin, jonka avulla sisältöä voi 

upottaa esimerkiksi Sharepoint-sivuille tai muille verkkosivustoille 

© Kolmen pisteen valikko, johon on koottu ne komennot, jotka eivät 

mahdu työkaluriville. 

Lisäksi palkin oikeassa reunassa on toimintoja, joiden avulla voit mm. 

resetoida (palauttaa) tekemäsi valinnat osittajista ja suodattimista, 

tallentaa itsellesi kirjanmerkkejä sekä valita raportin tarkastelunäkymä.  

Jos puolestaan tarkastelet sisältöä kehittäjänä työtilassa, näet valikoissa 

enemmän toiminnallisuuksia. 
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Sisällön käsittely muokkausoikeuksilla 

Kun olet joko omassa tai yhteisessä työtilassa, jossa sinulla on 

muokkausoikeudet, ikkunan yläosassa näkyy erilaisia sisältölajiin liittyviä 

toimintoja ja valikoita. 

Voit käsitellä kohteita riveillä olevien painikkeiden sekä kolmen pisteen 

takaa avautuvien valikoiden avulla. Raporteissa, koontinäytöissä, 

tietojoukoissa sekä tietovoissa on erilaisia toimintoja. 

 

 

 Huomaa 

Power BI –pilvipalvelu kehittyy kaiken aikaa ja käyttöliittymään 

ilmestyy uusia toimintoja. Tarkastele siis valikoita ja painikkeita 

avoimin silmin, saatat löytää hyödyllisiä uudistuksia. 
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Raporttien muokkaus selaimella 

Pilvipalvelussa näkyy Edit report (Muokkaa raporttia) -komento. Jos teet 

muutoksia selaimella, ne katoavat mikäli julkaiset PBI -tiedoston uudelleen 

aiemman päälle. Jos tallennat raportista kopion selaimella ja muokkaat 

kopiota, kopioon tekemäsi muutokset säilyvät, kun julkaiset Power BI -

tiedoston pilveen. 

 

 

 

Pääsääntöisesti ei ole hyvä idea muokata raportteja selaimella. Jos 

myöhemmin julkaiset tiedoston uudelleen Power BI Desktopista, selaimella 

tehdyt muutokset häviävät. 
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10.5 Koontinäytöt (Dashboards) 

Kun olet julkaissut raporttitiedoston pilveen, voit muodostaa siitä 

koontinäyttöjä (dashboards) ja jakaa niitä muille pilvipalvelun käyttäjille.  

Kiinnität visualisointeja koontinäytöille niiden oikeassa yläkulmassa olevan 

nastan avulla. Voit valita kohteeksi joko olemassa olevan koontinäytön tai 

luoda uusia kiinnittämisen yhteydessä.  

 

Samaan koontinäyttöön voi kiinnittää visualisointeja eri raporteista. Jos 

koontinäyttö jaetaan, muut saavat lukuoikeuden kaikkiin koontinäytön 

taustalla oleviin raportteihin.  

Koontinäytölle kiinnitetyt visualisoinnit eivät ole keskenään 

vuorovaikutteisia. Jos kiinnität koontinäytölle kokonaisen raporttisivun, 

mikä sekin on mahdollista, se on vuorovaikutteinen myös koontisivulla 

käytettynä, mutta kokonaisena kiinnitetty raporttisivu ei käyttäydy samalla 

tavalla kuin raportissa olleessaan. Koontinäytölle kiinnitetystä 

raporttisivusta puuttuu runsaasti ominaisuuksia, mikä saattaa hämmentää 

käyttäjiä. Löydät lisätietoja esimerkiksi täältä. 

  

https://hexcelligent.fi/2018/03/30/ohjeita-power-bi-raporttien-kayttajille/
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Koontinäytölle kiinnitettyjen visualisointien muokkaus 

Kun siirryt koontinäytölle (dashboard), voit muokata ja käsitellä 

koontinäytölle kiinnitettyä tiiltä ruudun oikeassa yläkulmassa olevan 

kolmen pisteen painikkeen avulla. 

 

 

Jakaminen muille käyttäjille 

Kun koontinäyttö on valmis, löydät yläpalkista jakopainikkeen. 
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Kaikki, joille jaat koontinäytön, saavat myös oikeuden lukea jokaista 

raporttia, josta on kiinnitetty elementtejä koontinäytölle. Jos myöhemmin 

kiinnität elementtejä toisesta raportista, lukijat saavat heti lukuoikeuden 

kyseiseen raporttiin.  
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Microsoft suosittelee tämän ”ad-hoc” jakotoiminnon käyttämistä lähinnä 

jakelultaan rajatuille kohderyhmille, kuten omalle tiimille. Isommille 

kohderyhmille suositellaan sovellusten eli appien julkaisemista.  

Muiden tiilien lisääminen koontinäytöille 

Voit lisätä koontinäytöille myös muita sisältölajeja, kuten tekstiä, kuvia, 

videoita tai muuta nettisivujen sisältöä. 

 

Kokonaisen live-raporttisivun kiinnittäminen koontinäytölle 

Voit kiinnittää kokonaisen raporttisivun koontinäytölle raporttisivun 

valikossa olevalla Pin to dashboard (Kiinnitä koontinäyttöön) -

komennolla. Huomaa, että kiinnitetyn sivun toiminnallisuuksissa on 

poikkeuksia. Raporteissa ei esimerkiksi toimi hierarkiat tai 

navigointipainikkeet. 
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Koontinäyttöjen Q & A -ominaisuus 

Koontinäytöillä voi tehdä englanninkielisiä kysymyksiä ja kysymysten 

tuloksia voi kiinnittää koontinäytöille. Kysymysten tuloksia eli 

visualisointeja voi myös muokata ja muotoilla ennen kiinnitystä. 

 

Koontinäyttöjen ja raporttien tarkastelu selaimella 

Jos esität lukuja selaimella, sinun kannattaa siirtyä koko näytön tilaan, 

jolloin turhat käyttöliittymäelementit piilotetaan näytöltä ja voit keskittyä 

pelkkään sisältöön. 

 

 

 

Kun kuljetat koko näytön tilassa hiirtä kohti oikeaa alakulmaa, saat esiin 

painikkeita, joilla navigoit raportilta toiselle tai poistut koko näytön tilasta. 
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10.6 Raporttien päivitys pilvipalvelussa 

Huomaa, että minkä tahansa tietojoukon (dataset) voi päivittää 

manuaalisesti käyttäjän toimesta avaamalla .pbix -tiedoston PBI Desktop -

ohjelmaan, suorittamalla päivityksen ja julkaisemalla päivittyneet tiedot 

uudelleen aiemmin julkaistun tilalle. 

Myös pilvipalvelussa voi suorittaa manuaalisen päivityksen tai ajastaa 

päivityksen: 

 

Pilvipalvelussa päivitys on mahdollista, jos: 

- tietolähde on pilvessä tai 

- tietolähde on omassa konesalissa olevalla servereillä tai esimerkiksi 

omassa työasemassa ja on asennettu ns. gateway –palvelu. Gateway-

palvelu muodostaa suojatun väylän pilven ja on-premises –

tietolähteen välille, jonka jälkeen päivitys on mahdollinen. Gateway 

asennetaan yleensä keskitetysti IT:n toimesta serverille, mutta se on 

saatavilla myös ns. henkilökohtaisena (personal) versiona. 

Henkilökohtainen gateway edellyttää, että työasema on käynnissä sinä 

ajanhetkenä kun raportti on ajastettu päivittymään. Lisätietoja löytyy 

täältä. 

Pro-lisenssimallissa tietolähteen voi ajastaa maksimissaan 8 krt 

vuorokaudessa, Premium-lisensseillä 48 krt vuorokaudessa. 

Raporttien ajoitusasetuksiin pääsee datasetin kohdalta Schedule Refresh 

(Ajoita päivitys) -painikkeen avulla. 

 

 

  

https://powerbi.microsoft.com/en-us/gateway/
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10.7 Jakaminen ja upottaminen 

Yksittäisten raporttien tai koontinäyttöjen jakaminen (share) 

Kun jaat yksittäin joko raportteja tai koontinäyttöjä raportteineen Share 

(Jaa) -komennolla, voit antaa oikeuksia yksittäisille käyttäjille, O365-

ryhmille ja jakelulistoille sekä esimerkiksi Azure AD -ryhmille.  

 

Jakamisen yhteydessä määrität myös, sallitko käyttäjien jakaa raportteja 

edelleen muille, sallitko käyttäjien luoda uusia raportteja joko Power BI:llä 

tai Excelillä jakamaasi dataan perustuen. Valitset myös, lähetätkö heille 

viestin, joka sisältää myös linkin sisältöön. 

Kun aloitat jaon Share (Jaa) -toiminnolla: 

1. Valitset ensin millä tavalla suoritat jaon. 

 

 
 

2. Vaihtoehtoina on jakaminen 1) kaikille organisaation jäsenille 2) 

henkilöille, joilla on jo oikeus (käytännössä tällä toiminnolla voit vain 

esimerkiksi kopioida linkin tai lähettää sen heille uudelleen) tai 3) 

tietyille määritetyille henkilöille. Valitse myös sallitko heidän jakaa 

sisältöä edelleen tai rakentaa sisällön pohjalta omia raportteja joko 

Power BI:llä tai Excelillä. 
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3. Määritä vielä kenelle haluat lähettää/jakaa sisällön ja kirjoita 

halutessasi viesti sekä lähetä se. 
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Jos et halua lähettää käyttäjille jaosta kertovaa sähköpostiviestiä, voit 

määrittää käyttöoikeudet Manage permissions (komennolla) tai käyttää 

raportin/koontinäytön valikosta löytyvää vastaavaa komentoa. 

 

 

 

 

Käyttämällä Manage permissions (Oikeuksien hallinta) -komentoa pääset 

myös myöhemmin tarkastelemaan sekä muokkaamaan käyttöoikeuksia. 
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10.8 Kokonaisuuksien jakaminen sovelluksina (apps) 

Laajoille käyttäjämäärille keskitetymmässä raportoinnissa Microsoft 

suosittelee jakamaan raportointikokonaisuuksia ns. appien avulla.  

Idea on se, että kokonainen työtila tai osa siitä paketoidaan ns. 

sovellukseksi.  

Tämän jälkeen sovellusta voi muokata rauhassa ja julkaista uusia versioita 

käyttäjille tarvittaessa.  

Sovellusten paketointi on yksinkertainen toimenpide ja siitä voi lukea 

lisätietoja täältä. 

Huomaa, että yhdestä työtilasta voi muodostaa vain yhden sovelluksen. 

Tästä syystä laajempien raportointikokonaisuuksien toteutuksessa 

kannattaa tutustua mahdollisuuteen luoda ns. keskitettyjä tietomalleja 

(shared datasets), joista muodostettuja raportteja voi julkaista eri 

työtiloihin, joita voi julkaista erilaisina sovelluksina eri kohderyhmille. 

Lisätietoja: https://exceleratorbi.com.au/new-power-bi-reports-golden-

dataset/  

Sovellus muodostetaan 1) valitsemalla Content (Sisältö) -näkymästä mitä 

työtilan sisältöjä sovellukseen paketoidaan (include in app-sarakkeesta) ja 

2) suorittamalla julkaisu ikkunan oikeassa yläkulmassa olevalla Create app 

(Luo sovellus) -komennolla. 

 

https://docs.microsoft.com/en-us/power-bi/service-how-to-collaborate-distribute-dashboards-reports
https://exceleratorbi.com.au/new-power-bi-reports-golden-dataset/
https://exceleratorbi.com.au/new-power-bi-reports-golden-dataset/
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Sovelluksen luonti sisältää kolme vaihetta eli näkymää. 

Ensimmäisellä Setup (Asennus) -välilehdellä sovellukselle annetaan nimi, 

kuvaus, tukisivuston osoite (jos sellainen on), logo sekä värimaailma. 
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Toisella välilehdellä rakennetaan navigaatio eli valikko (siirtyminen). 
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Kolmannella välilehdellä määritetään, kenelle sovellus jaetaan (oikeudet), 

asennetaanko se automaattisesti käyttäjille, sallitaanko käyttäjien luoda datasta 

omia Power BI -raportteja tai Excel-pivot-taulukoita tai tehdä raporteista omia 

henkilökohtaisia kopioita. 
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Skenaario: Useita sovelluksia useista tietojoukosta 

Koska yhdestä työtilasta voi julkaista vain yhden sovelluksen, laajemmat 

raportointiratkaisut muodostuvat yleensä useammasta työtilasta ja niistä 

luoduista sovelluksista. Tässä esitetty malli on vain viitteellinen, sillä 

jokaisessa organisaatiossa ja käyttötapauksessa pitää huomioida monia 

seikkoja.  

Oletetaan, että yrityksessä on oma työtila, johon julkaistaan erilaisia 

tietojoukkoja (dataset). Työtilan nimi on PBI Datasets. Kyseiseen työtilaan 

on julkaistu Taloushallinnon tietomalli, Tuotannon tietomalli, 

Markkinoinnin tietomalli ja Myynnin tietomalli. Tietomalleista halutaan 

luoda erilaisia raportteja eri kohderyhmille: 

- Yhtenä kohderyhmänä on johtoryhmä, joille toteutetaan raportteja 

kaikista neljästä tietomallista (dataset). 

- Yhtenä kohderyhmänä on myyjät, jolle toteutetaan raportteja sekä 

myynnin että talouden luvuista. 

- Yhtenä kohderyhmänä on myynti- & markkinointijohto, jolle 

toteutetaan raportteja sekä myynnin, markkinoinnin että talouden 

luvuista. 

- Yhtenä kohderyhmänä on Tuotannon johto, jolle toteutetaan 

raportteja sekä tuotannon että talouden luvuista. 

Kokonaisuus voisi muodostua viidestä työtilasta, joista yksi sisältäisi vain 

tekniikkaa (datasets) ja muissa olisi vain julkaistuja raportteja, jotka olisi 

paketoitu kullekin kohderyhmälle jaettaviksi sovelluksiksi. 

 

 

  

PBI Datasets -

niminen työtila, 

jossa on kaikki 

tarvittavat 

tietomallit 

Johtoryhmä  

Myyjät  

Myynti- & markkinointijohto 

Tuotannon johto 

Sovellus A 

Sovellus B 

Sovellus C 

Sovellus D 
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Sama raportti voi olla julkaistuna useissa eri työtiloissa, mutta eri 

työtiloihin on voitu julkaista myös erilaisia samasta tietomallista laadittuja 

raportteja. Oleellista on se, ettei logiikkaa eli tekniikkaa ole monistettu, 

vaan jokaisesta tietomallista on vain yksi toteutus. 

Kun toteutetaan laajempia kokonaisuuksia, työtilojen sisältöä voi 

tarkastella ns. Lineage view (Siirtymä) -näkymässä. Näkymän avulla pystyt 

tarkastelemaan, millaisia suhteita eri objektien välillä on, alkaen aina 

tietolähteistä erilaisiin raportteihin ja koontinäyttöihin asti. 
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10.9 Raporttien upottaminen 

Kun sisältöä on jaettu jollakin edellä kuvatuista tavoista tai ottamalla 

käyttäjiä jäseniksi työtiloihin, sisältöä voi upottaa eri sijainteihin. 

Upotusvaihtoehdot riippuvat organisaatiosi Power BI -asetuksista. 

 

 

 

Embed > SharePoint Online (Upota > SharePoint Online) mahdollistaa 

raporttien upotuksen SharePoint Online moderneille sivuille. Huomaa, että 

tämä komento antaa vain upotuskoodin, eli ei suorita varsinaista jakoa, 

joka pitää tehdä erikseen. 

Embed > Website or portal (Upota > Sivusto tai portaali) -komennolla 

saa koodin, jonka avulla raportin voi upottaa muulle kuin SharePoint 

online -sivustolle.  

Publish to web (Julkaise verkkoon (julkinen)) luo linkin sekä 

upotuskoodin, joiden avulla voit jakaa raportin kenelle tahansa tai upottaa 

sen nettisivuille. Tämä ominaisuus on voitu estää organisaatiossasi. Publish 

to web -komento on käytössä myös ilmaiskäyttäjillä, ellei sitä ole estetty. 
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Developer Playground (Kehittäjän testausalusta) on sellaisille 

sovelluskehittäjille tarkoitettu hiekkalaatikko, jotka toteuttavat erilaisia 

sovelluksia, joihin Power BI -raportteja upotetaan ohjelmallisesti 

sovelluskehitystekniikoiden avulla. Lisätietoja: Announcing the new Power 

BI embedded analytics playground (preview) | Microsoft Power BI Blog | 

Microsoft Power BI 

 

Jos olet luonut julkisia linkkejä raportteihisi (Publish to web), voit 

tarkastella ja poistaa niitä asetuspainikkeen takaa löytyvällä komennolla. 

Järjestelmänvalvojat pystyvät myös keskitetysti tarkistamaan mitä 

raportteja on jaettu julkisesti. 

 

 

  

https://powerbi.microsoft.com/en-us/blog/announcing-the-new-power-bi-embedded-analytics-playground-preview/
https://powerbi.microsoft.com/en-us/blog/announcing-the-new-power-bi-embedded-analytics-playground-preview/
https://powerbi.microsoft.com/en-us/blog/announcing-the-new-power-bi-embedded-analytics-playground-preview/
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10.10 Power BI Teamsissa 

 

Voit lisätä Power BI pilvipalvelun näkymään Teamsin 

navigointipalkissa, jotta pääset helposti tarkastelemaan 

Power BI -sisältöä. 

 Power BI -raportteja voi lisätä Teams-kanavaan välilehtinä 

(tabs). 

 

 

 

 Aloitat raporttiin tai koontinäyttöön liittyvän keskustelun 

helposti Power BI pilvipalvelusta raporttia tarkastellessasi. 
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10.11 Raporttien hyödyntäminen pilvipalvelussa 

Alla on listattu erilaisia muita raporttien hyödyntämisvaihtoehtoja. 

Sähköpostikirjautuminen 

Voit tilata (subscribe) sekä koontinäytöistä että raporteista 

sähköpostiviestin, joka saapuu, kun raportin tai koontinäytön sisältö on 

muuttunut. 

Viestejä voi tilata myös muille käyttäjille. 

 

Hälytykset (alerts) 

Voit tilata henkilökohtaisen hälytyksen 

koontinäytölle kiinnitetystä kortista 

(card) tai KPI-visualisoinnista.  

Hälytys löytyy koontinäytöllä olevan 

kortin kolmen pisteen painikkeen takaa 

ja hälytykseen voi määrittää säännön, 

milloin haluat saada ilmoituksen kortissa 

olevan luvun muutoksesta. 

Hälytyksen voi kytkeä myös Microsoft 

Power Automate -työnkulkuun, Power 

Automaten avulla hälytyksen voi lähettää 

myös muille käyttäjille.  

Jos esimerkiksi jossakin koontinäytöllä 

olevassa kortissa on tuotannossa 

tapahtuneiden virheiden määrä, voisi 

tilata hälytyksen, kun hälytysten määrä 

ylittää tietyn rajan. 
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Excelissä analysointi 

Voit ryhtyä tekemään julkaistusta tietojoukosta Excelissä Pivot-taulukoita. 

Mikäli toiminto on sallittu, Analyze in Excel (Analysoi Excelissä) komento 

löytyy kolmen pisteen valikosta. 

Tällöin kaikki laskennalliset arvot on pitänyt luoda malliin DAX-mittareina 

(measures). Excelissä ei voi valita pivot-taulukon laskenta-alueelle 

laskettua saraketta tai tavallista tietosaraketta. 
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11 Mitä seuraavaksi? 

11.1 DAX ja mallinnus 

DAX-kielestä on olemassa 3-tuntinen ilmainen johdantokurssi: 

- https://www.sqlbi.com/articles/start-learning-dax-for-free/  

Datan mallinnuksesta löytyy runsaasti dokumentaatiota, mutta Matt 

Allingtonin sivustolla on hyvä kokonaisuus: 

- https://exceleratorbi.com.au/the-optimal-shape-for-power-pivot-

data/  

Huomaa, että osa sivuston artikkeleista on kirjoitettu jo aikana ennen 

Power BI:tä eli Power Pivotin näkökulmasta. Samat periaatteet pätevät 

myös Power BI:ssä. Artikkelit löytyvät Key Concepts -valikosta ja joukossa 

on hyviä selkokielisiä artikkeleita. 

11.2 Lisätietoja pilvipalvelun arkkitehtuuri 

Selvitä millainen sinun organisaatiosi raportointiarkkitehtuuri on. Jos olet 

itse suunnittelemassa Power BI:n käyttöä, tutustu aiheisiin dataflows 

(tietovuot) ja shared datasets (jaetut tietojoukot). 

Jos olet Power BI -raportin ainoa kehittäjä ja teet melko suppeita 

raportointikokonaisuuksia, työskentelet todennäköisesti yksittäisten .pbix-

tiedoston parissa. Luot tällöin kuhunkin .pbix tiedostoon sekä kyselyt, 

tietomallin että tarvittavat raportit. 

Jos kehittäjiä on useita ja he tuottavat raportointia samoista tietolähteistä, 

ratkaisut on hyvä pyrkiä toteuttamaan mahdollisimman keskitetysti eli 

pyrkiä välttämään logiikan kopioitumista useisiin tiedostoihin, sillä ylläpito 

ja muokkaus muuttuvat hankalaksi ja samoja ylläpitotoimintoja pitää 

suorittaa useissa tiedostoissa. Laajempiin ratkaisuihin suositellaan usein 

kolmikerrosarkkitehtuuria, missä eri vaiheet toteutetaan omina 

kerroksinaan. Kyselyt voi toteuttaa pilvipalvelussa ns. dataflows (tietovuo) 

entiteetteinä, tietomallit puolestaan ns. jaettuina tietomalleina (shared 

datasets) ja lopulta raportit toteutetaan erillisiin Power BI -tiedostoihin. 

Tällöin myös vastuuta ja tekemistä voi jakaa eri henkilöille.  

  

https://www.sqlbi.com/articles/start-learning-dax-for-free/
https://exceleratorbi.com.au/the-optimal-shape-for-power-pivot-data/
https://exceleratorbi.com.au/the-optimal-shape-for-power-pivot-data/
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Kuvassa Dataflows (tietovuo) tarkoittaa pilvipalveluun tallennettuja Power Query 

-kyselyitä, joihin voi ottaa yhteyden PBI Desktopista ja toteuttaa niiden pohjalta 

tietomalllin DAX-mittareineen. 

 

Tietomallitiedostot puolestaan julkaistaan pilvipalveluun datasettinä 

(tietojoukkona), joihin voi ottaa yhteyden PBI Desktopista ja luoda niiden 

pohjalta erilaisia raporttikokonaisuuksia eri tiedostoihin. 

 

Raporttitiedostot julkaistaan lopulta työtiloihin ja jaetaan käyttäjille halutuilla 

tekniikoilla eli joko paketoimalla ne applikaatioiksi, jakamalla yksittäisinä 

objekteina tai työtilan jäsenyyteen perustuen. 
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Power BI Report Server -ympäristössä ei ole tietovuo-tauluja eikä jaettuja 

tietojoukkoja. On-prem ratkaisuissa eli Power BI Report Server -ympäristössä 

keskitetyt mallit voi toteuttaa SQL Server Analysis Services -malleina ja tuottaa 

raportit Power BI:llä. 
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12 Muita lisätietoja pilvipalvelusta 

© Työtilat (Workspaces): https://docs.microsoft.com/en-us/power-

bi/service-new-workspaces 

© Raportit (Reports) Power BI -palvelussa: 

https://docs.microsoft.com/en-us/power-bi/consumer/end-user-

reports 

© Koontinäytöt (dashboards): https://docs.microsoft.com/en-us/power-

bi/service-dashboards 

© Sovellukset (apps): https://docs.microsoft.com/en-us/power-

bi/consumer/end-user-apps 

© Tietovuot (Dataflows): https://docs.microsoft.com/en-us/power-

bi/service-dataflows-overview  

© Premium-lisenssiin liittyvä elinkaaren hallintatyökalu, jolla toteutetaan 

ns. käyttöönottoputkia (development pipelines): Power BI Application 

lifecycle management (ALM) deployment pipelines overview - Power 

BI | Microsoft Docs 

© Premium-lisenssiin liittyvät tavoitteet (Goals): Introducing Goals in 

Power BI | Microsoft Power BI Blog | Microsoft Power BI 

© Premium-lisenssiin sisältyvä Power BI Report Builder -työkalu 

sivutettavien raporttien laatimiseen (paginated reports): Power BI 

Report Builder - Power BI | Microsoft Docs 

 

 

https://docs.microsoft.com/en-us/power-bi/service-new-workspaces
https://docs.microsoft.com/en-us/power-bi/service-new-workspaces
https://docs.microsoft.com/en-us/power-bi/consumer/end-user-reports
https://docs.microsoft.com/en-us/power-bi/consumer/end-user-reports
https://docs.microsoft.com/en-us/power-bi/service-dashboards
https://docs.microsoft.com/en-us/power-bi/service-dashboards
https://docs.microsoft.com/en-us/power-bi/consumer/end-user-apps
https://docs.microsoft.com/en-us/power-bi/consumer/end-user-apps
https://docs.microsoft.com/en-us/power-bi/service-dataflows-overview
https://docs.microsoft.com/en-us/power-bi/service-dataflows-overview
https://docs.microsoft.com/en-us/power-bi/create-reports/deployment-pipelines-overview
https://docs.microsoft.com/en-us/power-bi/create-reports/deployment-pipelines-overview
https://docs.microsoft.com/en-us/power-bi/create-reports/deployment-pipelines-overview
https://powerbi.microsoft.com/en-us/blog/introducing-goals-in-power-bi/
https://powerbi.microsoft.com/en-us/blog/introducing-goals-in-power-bi/
https://docs.microsoft.com/en-us/power-bi/paginated-reports/report-builder-power-bi
https://docs.microsoft.com/en-us/power-bi/paginated-reports/report-builder-power-bi

